PIVOT TABLE DATA CRUNCHING

This book is part of Que’s exciting new Content Update Program, which provides automatic content updates for major technology improvements!

› As Microsoft makes significant updates to Excel 2016, sections of this book will be updated or new sections will be added to match the updates to the software.

› The updates will be delivered to you via a free Web Edition of this book, which can be accessed with any Internet connection.

› This means your purchase is protected from immediately outdated information!

For more information on Que’s Content Update program, see the inside back cover or go to www.quepublishing.com/CUP.

If you have additional questions, please email our Customer Service department at informit@custhelp.com.
Excel® 2016
Pivot Table Data Crunching

Bill Jelen
Michael Alexander
Contents

Introduction ........................................................................................................................................ 1
  What You Will Learn from This Book .......................................................................................... 1
  What Is New in Excel 2016’s Pivot Tables .................................................................................. 2
  Skills Required to Use This Book ............................................................................................ 3
  Invention of the Pivot Table ....................................................................................................... 4
  Sample Files Used in This Book ............................................................................................... 6
  Conventions Used in This Book ............................................................................................... 6
    Referring to Versions .............................................................................................................. 7
    Referring to Ribbon Commands ............................................................................................ 7
    Special Elements .................................................................................................................. 7

1 Pivot Table Fundamentals ..................................................................................................... 9
  Defining a Pivot Table .............................................................................................................. 9
  Why You Should Use a Pivot Table .......................................................................................... 10
    Advantages of Using a Pivot Table ....................................................................................... 11
  When to Use a Pivot Table ....................................................................................................... 12
  Anatomy of a Pivot Table ........................................................................................................ 12
    Values Area .......................................................................................................................... 12
    Rows Area ........................................................................................................................... 13
    Columns Area ..................................................................................................................... 14
    Filters Area ........................................................................................................................ 14
  Pivot Tables Behind the Scenes ............................................................................................... 14
  Pivot Table Backward Compatibility ..................................................................................... 15
    A Word About Compatibility ............................................................................................... 16
  Next Steps .............................................................................................................................. 17

2 Creating a Basic Pivot Table ................................................................................................. 19
  Preparing Data for Pivot Table Reporting ............................................................................... 19
    Ensuring That Data Is in a Tabular Layout .......................................................................... 20
    Avoiding Storing Data in Section Headings ....................................................................... 20
    Avoiding Repeating Groups as Columns .......................................................................... 21
    Eliminating Gaps and Blank Cells in the Data Source ...................................................... 22
    Applying Appropriate Type Formatting to Fields ............................................................... 22
    Summary of Good Data Source Design .............................................................................. 22
  How to Create a Basic Pivot Table ......................................................................................... 24
    Adding Fields to a Report ..................................................................................................... 26
    Fundamentals of Laying Out a Pivot Table Report ......................................................... 27
    Adding Layers to a Pivot Table ........................................................................................... 28
    Rearranging a Pivot Table ................................................................................................... 29
    Creating a Report Filter ....................................................................................................... 31
  Understanding the Recommended Pivot Table Feature ..................................................... 31
  Using Slicers ......................................................................................................................... 33
    Creating a Standard Slicer ................................................................................................. 33
5 Performing Calculations in Pivot Tables .............................................................................................................113

Introducing Calculated Fields and Calculated Items ..................................................................................................................113

Method 1: Manually Add a Calculated Field to the Data Source ..........................................................................................114

Method 2: Use a Formula Outside a Pivot Table to Create a Calculated Field ........................................................................115

Method 3: Insert a Calculated Field Directly into a Pivot Table ..............................................................................................116

Creating a Calculated Field .........................................................................................................................................................116

Creating a Calculated Item .........................................................................................................................................................117

Understanding the Rules and Shortcomings of Pivot Table Calculations ................................................................................127

Remembering the Order of Operator Precedence ....................................................................................................................128

Using Cell References and Named Ranges ...............................................................................................................................129

Using Worksheet Functions ......................................................................................................................................................129

Using Constants ........................................................................................................................................................................129

Referencing Totals .......................................................................................................................................................................129

Rules Specific to Calculated Fields ........................................................................................................................................129

Rules Specific to Calculated Items ........................................................................................................................................131
8 Sharing Pivot Tables with Others ................................................................. 193
  Designing a Workbook as an Interactive Web Page .................................................. 193
  Sharing a Link to a Web Workbook ............................................................................... 196
  Sharing with Power BI ........................................................................................................ 196
    Preparing Data for Power BI ......................................................................................... 197
    Importing Data to Power BI ......................................................................................... 197
    Building a Report in Power BI ....................................................................................... 199
    Using Q&A to Query Data ............................................................................................. 200
    Sharing Your Dashboard ............................................................................................... 202
  Next Steps ..................................................................................................................... 202

9 Working with and Analyzing OLAP Data ............................................................... 203
  Introduction to OLAP ....................................................................................................... 203
  Connecting to an OLAP Cube ......................................................................................... 204
  Understanding the Structure of an OLAP Cube ............................................................ 207
  Understanding the Limitations of OLAP Pivot Tables ..................................................... 208
    Creating an Offline Cube ............................................................................................... 209
  Breaking Out of the Pivot Table Mold with Cube Functions ............................................. 211
    Exploring Cube Functions ........................................................................................... 212
  Adding Calculations to OLAP Pivot Tables ..................................................................... 213
    Creating Calculated Measures ...................................................................................... 214
    Creating Calculated Members ...................................................................................... 217
    Managing OLAP Calculations ...................................................................................... 220
    Performing What-If Analysis with OLAP Data .............................................................. 220
  Next Steps ..................................................................................................................... 222

10 Mashing Up Data with Power Pivot ................................................................. 223
  Understanding the Benefits and Drawbacks of Power Pivot and the Data Model .............. 223
    Merging Data from Multiple Tables Without Using VLOOKUP .................................. 223
    Importing 100 Million Rows into a Workbook ............................................................ 224
    Creating Better Calculations Using the DAX Formula Language .................................. 224
    Other Benefits of the Power Pivot Data Model in All Editions of Excel ......................... 224
    Benefits of the Full Power Pivot Add-in with Excel Pro Plus ....................................... 225
    Understanding the Limitations of the Data Model ......................................................... 225
  Joining Multiple Tables Using the Data Model in Regular Excel 2016 ......................... 226
    Preparing Data for Use in the Data Model .................................................................. 227
    Adding the First Table to the Data Model .................................................................... 227
    Adding the Second Table and Defining a Relationship ............................................... 229
    Tell Me Again—Why Is This Better Than Doing a VLOOKUP? ...................................... 230
    Creating a New Pivot Table from an Existing Data Model ........................................... 232
    Getting a Distinct Count .............................................................................................. 232
  Using the Power Pivot Add-in Excel 2016 Pro Plus ....................................................... 234
    Enabling Power Pivot ................................................................................................... 234
    Importing a Text File Using Power Query .................................................................... 235
### 11 Dashboarding with Power View and 3D Map

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preparing Data for Power View</td>
<td>245</td>
</tr>
<tr>
<td>Creating a Power View Dashboard</td>
<td>247</td>
</tr>
<tr>
<td>Adding Excel Data by Linking</td>
<td>236</td>
</tr>
<tr>
<td>Defining Relationships</td>
<td>236</td>
</tr>
<tr>
<td>Adding Calculated Columns Using DAX</td>
<td>237</td>
</tr>
<tr>
<td>Building a Pivot Table</td>
<td>237</td>
</tr>
<tr>
<td>Understanding Differences Between Power Pivot and Regular Pivot Tables</td>
<td>238</td>
</tr>
<tr>
<td>Using DAX Calculations</td>
<td>239</td>
</tr>
<tr>
<td>Using DAX Calculations for Calculated Columns</td>
<td>239</td>
</tr>
<tr>
<td>Using DAX to Create a Calculated Field in a Pivot Table</td>
<td>240</td>
</tr>
<tr>
<td>Filtering with DAX Calculated Fields</td>
<td>240</td>
</tr>
<tr>
<td>Defining a DAX Calculated Field</td>
<td>240</td>
</tr>
<tr>
<td>Using Time Intelligence</td>
<td>242</td>
</tr>
<tr>
<td>Next Steps</td>
<td>243</td>
</tr>
<tr>
<td>Adding Calculated Columns Using DAX</td>
<td>240</td>
</tr>
<tr>
<td>Using DAX Calculations for Calculated Columns</td>
<td>239</td>
</tr>
<tr>
<td>Using DAX to Create a Calculated Field in a Pivot Table</td>
<td>240</td>
</tr>
<tr>
<td>Filtering with DAX Calculated Fields</td>
<td>240</td>
</tr>
<tr>
<td>Defining a DAX Calculated Field</td>
<td>240</td>
</tr>
<tr>
<td>Using Time Intelligence</td>
<td>242</td>
</tr>
<tr>
<td>Next Steps</td>
<td>243</td>
</tr>
<tr>
<td>Replicating Charts Using Multiples</td>
<td>256</td>
</tr>
<tr>
<td>Showing Data on a Map</td>
<td>257</td>
</tr>
<tr>
<td>Using Images</td>
<td>258</td>
</tr>
<tr>
<td>Changing a Calculation</td>
<td>259</td>
</tr>
<tr>
<td>Animating a Scatter Chart over Time</td>
<td>259</td>
</tr>
<tr>
<td>Some Closing Tips on Power View</td>
<td>261</td>
</tr>
<tr>
<td>Analyzing Geographic Data with 3D Map</td>
<td>261</td>
</tr>
<tr>
<td>Preparing Data for 3D Map</td>
<td>261</td>
</tr>
<tr>
<td>Geocoding Data</td>
<td>262</td>
</tr>
<tr>
<td>Building a Column Chart in 3D Map</td>
<td>264</td>
</tr>
<tr>
<td>Navigating Through the Map</td>
<td>264</td>
</tr>
<tr>
<td>Labeling Individual Points</td>
<td>266</td>
</tr>
<tr>
<td>Building Pie or Bubble Charts on a Map</td>
<td>266</td>
</tr>
<tr>
<td>Using Heat Maps and Region Maps</td>
<td>266</td>
</tr>
<tr>
<td>Exploring 3D Map Settings</td>
<td>267</td>
</tr>
<tr>
<td>Fine-Tuning 3D Map</td>
<td>268</td>
</tr>
<tr>
<td>Animating Data over Time</td>
<td>269</td>
</tr>
<tr>
<td>Building a Tour</td>
<td>270</td>
</tr>
</tbody>
</table>
Creating a Video from 3D Map.................................................................271
Next Steps..................................................................................................274

12 Enhancing Pivot Table Reports with Macros...........................................275
Why Use Macros with Pivot Table Reports..............................................275
Recording a Macro.....................................................................................276
Creating a User Interface with Form Controls.........................................278
Altering a Recorded Macro to Add Functionality.......................................280
Inserting a Scrollbar Form Control............................................................281
Next Steps..................................................................................................288

13 Using VBA to Create Pivot Tables..........................................................289
Enabling VBA in Your Copy of Excel..........................................................289
Using a File Format That Enables Macros..................................................290
Visual Basic Editor......................................................................................291
Visual Basic Tools......................................................................................291
The Macro Recorder....................................................................................292
Understanding Object-Oriented Code.......................................................292
Learning Tricks of the Trade.........................................................................293
Writing Code to Handle a Data Range of Any Size......................................293
Using Super-Variables: Object Variables..................................................294
Using With and End With to Shorten Code.................................................295
Understanding Versions..............................................................................295
Building a Pivot Table in Excel VBA...........................................................296
Adding Fields to the Data Area.....................................................................298
Formatting the Pivot Table..........................................................................299
Dealing with Limitations of Pivot Tables....................................................301
Filling Blank Cells in the Data Area............................................................301
Filling Blank Cells in the Row Area............................................................302
Preventing Errors from Inserting or Deleting Cells.....................................302
Controlling Totals.......................................................................................302
Converting a Pivot Table to Values.............................................................304
Pivot Table 201: Creating a Report Showing Revenue by Category............307
Ensuring That Tabular Layout Is Utilized....................................................309
Rolling Daily Dates Up to Years.................................................................309
Eliminating Blank Cells..............................................................................311
Controlling the Sort Order with AutoSort..................................................312
Changing the Default Number Format......................................................312
Suppressing Subtotals for Multiple Row Fields..........................................313
Handling Final Formatting.........................................................................315
Adding Subtotals to Get Page Breaks..........................................................315
Putting It All Together..............................................................................317
Contents

Tip 14: Apply Restrictions on Pivot Tables and Pivot Fields ....................................................................................................368
Pivot Table Restrictions ...................................................................................................................................................368
Pivot Field Restrictions ....................................................................................................................................................370
Tip 15: Use a Pivot Table to Explode a Data Set to Different Workbooks ................................................................................372
Next Steps..............................................................................................................................................................................373

15 Dr. Jekyll and Mr. GetPivotData ........................................................................................................................................375
Avoiding the Evil GetPivotData Problem ..........................................................................................................................376
Preventing GetPivotData by Typing the Formula .................................................................................................................379
Simply Turning Off GetPivotData .....................................................................................................................................379
Speculating on Why Microsoft Forced GetPivotData on Us ..............................................................................................380
Using GetPivotData to Solve Pivot Table Annoyances ............................................................................................................381
Building an Ugly Pivot Table ............................................................................................................................................382
Building the Shell Report .................................................................................................................................................385
Using GetPivotData to Populate the Shell Report ............................................................................................................387
Updating the Report in Future Months ............................................................................................................................390
Conclusion .............................................................................................................................................................................391

Index ..................................................................................................................................................................................393
About the Authors

Bill Jelen, Excel MVP and the host of MrExcel.com, has been using spreadsheets since 1985, and he launched the MrExcel.com website in 1998. Bill was a regular guest on Call for Help with Leo Laporte and has produced more than 1,900 episodes of his daily video podcast, Learn Excel from MrExcel. He is the author of 49 books about Microsoft Excel and writes the monthly Excel column for Strategic Finance magazine. Before founding MrExcel.com, Bill Jelen spent 12 years in the trenches, working as a financial analyst for the finance, marketing, accounting, and operations departments of a $500 million public company. He lives in Merritt Island, Florida, with his wife, Mary Ellen.

Mike Alexander is a Microsoft Certified Application Developer (MCAD) and author of several books on advanced business analysis with Microsoft Access and Excel. He has more than 15 years of experience consulting and developing Office solutions. Mike has been named a Microsoft MVP for his ongoing contributions to the Excel community. In his spare time, he runs a free tutorial site, www.datapigtechnologies.com, where he shares basic Access and Excel tips to the Office community.

Dedication

To my friend, the recently departed Professor Simon Benninga
—Bill Jelen

To my 12 fans at datapigtechnologies.com
—Mike Alexander
Acknowledgments

Mike Alexander is the funniest guy doing live Excel seminars. I appreciate him as a coauthor on all five editions of this book, which has earned the #1 spot on the Amazon Computer Book bestseller list (for 54 minutes one day in January). Rob Collie of PowerPivotPro.com keeps me up to speed on PowerPivot. At Microsoft, thanks to Aviv Ezrachi and Ben Rampson for always being willing to answer quick questions. At MrExcel.com, thanks to an entire community of people who are passionate about Excel. Finally, thanks to my wife, Mary Ellen, for her support during the writing process.

—Bill Jelen

Thanks to Bill Jelen for deciding to coauthor this book with me many editions ago. His knowledge of Excel still blows me away to this day. My deepest thanks to the professionals at Pearson Education for all the hours of work put into bringing this book to life. Thanks also to Bob Umlas, whose technical editing has helped us make numerous improvements to the examples and text in this book. Finally, a special thank you goes to the wife and kids for putting up with all the time I spent locked away on this project.

—Mike Alexander
We Want to Hear from You!

As the reader of this book, you are our most important critic and commentator. We value your opinion and want to know what we’re doing right, what we could do better, what areas you’d like to see us publish in, and any other words of wisdom you’re willing to pass our way.

We welcome your comments. You can email or write to let us know what you did or didn’t like about this book—as well as what we can do to make our books better.

Please note that we cannot help you with technical problems related to the topic of this book.

When you write, please be sure to include this book’s title and author as well as your name and email address. We will carefully review your comments and share them with the author and editors who worked on the book.

E-mail: feedback@quepublishing.com

Mail: Que Publishing
ATTN: Reader Feedback
800 East 96th Street
Indianapolis, IN 46240 USA

Reader Services

Visit our website and register this book at quepublishing.com/register for convenient access to any updates, downloads, or errata that might be available for this book.
The pivot table is the single most powerful command in all of Excel. Pivot tables came along during the 1990s, when Microsoft and Lotus were locked in a bitter battle for dominance of the spreadsheet market. The race to continually add enhanced features to their respective products during the mid-1990s led to many incredible features, but none as powerful as the pivot table.

With a pivot table, you can transform one million rows of transactional data into a summary report in seconds. If you can drag a mouse, you can create a pivot table. In addition to quickly summarizing and calculating data, pivot tables enable you to change your analysis on the fly by simply moving fields from one area of a report to another.

No other tool in Excel gives you the flexibility and analytical power of a pivot table.

What You Will Learn from This Book

It is widely agreed that close to 60% of Excel users leave 80% of Excel untouched. That is, most users do not tap into the full potential of Excel’s built-in utilities. Of these utilities, the most prolific by far is the pivot table. Despite the fact that pivot tables have been a cornerstone of Excel for almost 20 years, they remain one of the most underutilized tools in the entire Microsoft Office suite.

Having picked up this book, you are savvy enough to have heard of pivot tables—and you have perhaps even used them on occasion. You have a sense that pivot tables provide a power that you are not using, and you want to learn how to leverage that power to increase your productivity quickly.

Within the first two chapters, you will be able to create basic pivot tables, increase your productivity, and produce reports in minutes instead of hours. Within the first seven chapters, you will be able to
output complex pivot reports with drill-down capabilities and accompanying charts. By the end of the book, you will be able to build a dynamic pivot table reporting system.

What Is New in Excel 2016’s Pivot Tables

Luckily, Microsoft continues to invest heavily in business intelligence (BI), and pivot tables are the front end that let you access the new features. Some of the features added to Excel 2016 pivot tables include the following:

- Pivot tables now provide auto grouping for date or time columns. If you add a date column to the Rows or Columns area, Excel will automatically group the data up to Months and collapse to Months. If the data spans more than one year, Excel will add Quarters and Years as well. If you add a time column, Excel will automatically group to Seconds, Minutes, and Hours and collapse to show only the top level.
- Pivot charts offer expand and collapse buttons. If you add two or more fields to the Axis or Legend area of a pivot table, you can use the + and − icons on the pivot chart to zoom in and out on the hierarchy.
- Slicers now offer a Multi-Select icon to allow you to choose multiple items without using the Ctrl key. This feature was added for touchscreens.
- If your data has a geographic field such as for addresses or postal codes, you can build a pivot table on a map by using the 3D Maps icon on the Insert tab.
- If you need to import data for a pivot table, the Power Query tools found under Data, Get & Transform will assist you in cleaning and shaping that data.
- Power Pivot has an automatic feature for creating a calendar table.
- If you select Insert PivotTable from a blank cell, and if there is a Data Model in the workbook, Excel will offer to build the pivot table from the model.
- Power Pivot’s Auto-Detect Relationships dialog offers a Manage Relationships button that allows you to review or correct any relationship that was detected.

If you skipped right over Excel 2013, you may not know about some of the new features it introduced. Here are some of the best ones:

- Beginning with 2013, Excel offers thumbnails for 10 recommended pivot tables when you choose Insert, Recommended Pivot Tables. If you are not sure how best to summarize your data, you’ll find plenty of inspiration in this dialog.
- A timeline slicer enables you to easily filter a pivot table by month, quarter, or year.
- Excel 2013 introduced the Data Model as a way to build a pivot table from two tables. This is for the versions of Excel that do not offer Power Pivot.
- People using Office Professional Plus, Office 365 Pro Plus, or other high-end editions can enable the Power Pivot add-in. Power Pivot provides drag-and-drop functionality to link tables, worksheets, SQL Server, and more. Power Pivot adds better calculated fields.
- Power View enables you to animate pivot tables in an ad hoc query tool.
Skills Required to Use This Book

This book is a comprehensive enough reference for hard-core analysts yet relevant to casual users of Excel. The bulk of the book covers how to use pivot tables in the Excel user interface. Chapter 10, “Mashing Up Data with Power Pivot,” delves into the Power Pivot window. Chapter 14, “Advanced Pivot Table Tips and Techniques,” describes how to create pivot tables in Excel’s powerful VBA macro language. Any user who has a firm grasp of basics such as preparing data, copying, pasting, and entering simple formulas should not have a problem understanding the concepts in this book.

CASE STUDY: LIFE BEFORE PIVOT TABLES

Say that your manager asks you to create a one-page summary of a sales database. He would like to see total revenue by region and product. Suppose you do not know how to use pivot tables. You will have to use dozens of keystrokes or mouse clicks to complete this task.

First, you have to build the outline of the report:

1. Copy the Product column to a blank section of the worksheet.
2. Select Data, Remove Duplicates to eliminate the duplicates.
3. Delete the Product heading.
4. Copy the unique list of products and then use Paste Special Transpose to turn the list sideways.
5. Delete the vertical list of products.
6. Copy the Region column to a blank section of the worksheet.
7. Select Data, Remove Duplicates to remove the duplicates.
8. Delete the Region heading.
9. Cut and paste the products so they appear left of and below the regions.

At this point, with 27 mouse clicks or keystrokes, you’ve built the shell of the final report, but there are no numbers inside yet (see Figure I.1).

Next, you need to build the relatively new SUMIFS function to total the revenue for the intersection of a region and product. As shown in Figure I.2, the formula =SUMIFS($G$2:$G$564,$C$2:$C$564,L$1,$B$2:$B$564,$K2) does the trick. It takes 52 characters plus the Enter key to finish the formula, but I managed to enter the formula in 36 clicks or keystrokes by using some clever navigation tricks I’ve learned over the years.
Invention of the Pivot Table

When the actual pivot table was invented is in dispute. The Excel team coined the term *pivot table*, which appeared in Excel in 1993. However, the concept was not new. Pito Salas and his team at Lotus were working on the pivot table concept in 1986 and released Lotus Improv in 1991. Before then, Javelin offered functionality similar to that of pivot tables.

The core concept behind a pivot table is that the data, formulas, and data views are stored separately. Each column has a name, and you can group and rearrange the data by dragging field names to various positions on the report.
CASE STUDY: LIFE AFTER PIVOT TABLES

Say that you’re tired of working so hard to remake reports every time your manager wants a change. You’re in luck: You can produce the same report as in the last case study but using a pivot table. Excel 2016 offers you 10 thumbnails of recommended pivot tables to get you close to the goal. Follow these steps:

1. Click the Insert tab of the ribbon.
2. Click Recommended PivotTables. The first recommended item is Revenue by Region (see Figure I.4).
3. Click OK to accept the first pivot table.
4. Drag the Product field from the PivotTable Fields list to the Columns area (see Figure I.5).

Figure I.4
The first recommended pivot table is as close as you will get to the required report.

Figure I.5
To finish the report, drag the Product heading to the Columns area.
5. Unselect Field Headers on the right side of the ribbon.

With just five clicks of the mouse, you have the report shown in Figure I.6.

![Figure I.6](image)

It took five clicks to create this report.

In addition, when your manager comes back with a request like the ones near the end of the prior case study, you can easily use the pivot table makes to make the changes. Here’s a quick overview of the changes you’ll learn to make in the chapters that follow:

- Could you put products down the side and regions across the top? (This change will take you 10 seconds: Drag Product to Rows and Region to Columns.)
- Could you show me the same report for only the manufacturing customers? (15 seconds: Select Insert Slicer, Sector; click OK; click Manufacturing.)
- Could you show profit instead of revenue? (10 seconds: Uncheck Revenue, check Profit.)
- Could you copy this report for each of the customers? (30 seconds: Move Customer to Report Filter, open the tiny drop-down next to the Options button, choose Show Report Filter Pages, click OK.)

Sample Files Used in This Book

All data files used throughout this book are available for download from [www.mrexcel.com/pivotbookdata2016.html](http://www.mrexcel.com/pivotbookdata2016.html). You will find one Excel workbook per chapter and should be able to achieve exactly the same results shown in the figures in this book by starting with the raw data on the Data worksheet. If you simply want to work with the final pivot table, you can find it in the workbook as well.

Conventions Used in This Book

This book follows certain conventions:

- **Monospace**—Code and messages you see onscreen appear in a monospace font.
- **Bold**—Text you type appears in a bold font.
Conventions Used in This Book

- *Italic*—New and important terms appear in italics.
- Initial Caps—Tab names, dialog names, and dialog elements are presented with initial capital letters so you can identify them easily.

Referring to Ribbon Commands

When the active cell is inside a pivot table, two new tabs appear on the ribbon. In the help files, Microsoft calls these tabs “PivotTable Tools | Analyze” and “PivotTable Tools | Design.” For convenience, this book refers to these elements as the Analyze tab and the Design tab, respectively. The Slicer feature has a ribbon tab that Microsoft calls “Slicer Tools | Options.” This book refers to this as the Slicer tab. Excel 2013 introduced the “Timeline Tools | Options” tab. This book calls this the Timeline tab.

In some cases, the ribbon icon leads to a drop-down with additional choices. In these cases, the book lists the hierarchy of ribbon, icon, menu choice, and submenu choice. For example, Figure I.7 shows what you would select if the book said “select Design, Report Layout, Repeat All Item Labels.”

![Figure I.7](image)

For shorthand, instructions might say to select Design, Report Layout, Repeat All Item Labels.

Special Elements

This book contains the following special elements:

**CASE STUDY**

Case studies provide real-world examples involving topics previously introduced in the chapter.
Notes provide additional information outside the main thread of the chapter discussion that might be useful for you to know.

Tips provide quick workarounds and time-saving techniques to help you do your work more efficiently.

Cautions warn you about potential pitfalls you might encounter. Pay attention to cautions because they alert you to problems that could cause you hours of frustration.
Customizing a Pivot Table

Although pivot tables provide an extremely fast way to summarize data, sometimes the pivot table defaults are not exactly what you need. In such cases, you can use many powerful settings to tweak pivot tables. These tweaks range from making cosmetic changes to changing the underlying calculation used in the pivot table.

In Excel 2016, you find controls to customize a pivot table in myriad places: the Analyze tab, Design tab, Field Settings dialog, Data Field Settings dialog, PivotTable Options dialog, and context menus.

Rather than cover each set of controls sequentially, this chapter covers the following functional areas in making pivot table customization:

- **Minor cosmetic changes**—Change blanks to zeros, adjust the number format, and rename a field. The fact that you must correct these defaults in every pivot table that you create is annoying.
- **Layout changes**—Compare three possible layouts, show/hide subtotals and totals, and repeat row labels.
- **Major cosmetic changes**—Use pivot table styles to format a pivot table quickly.
- **Summary calculations**—Change from Sum to Count, Min, Max, and more. In a pivot table that defaults to Count of Revenue, change it to default to Sum of Revenue instead.
- **Advanced calculations**—Use settings to show data as a running total, percent of total, rank, percent of parent item, and more.
- **Other options**—Review some of the obscure options found throughout the Excel interface.
Making Common Cosmetic Changes

You need to make a few changes to almost every pivot table to make it easier to understand and interpret. Figure 3.1 shows a typical pivot table. To create this pivot table, open the Chapter 3 data file. Select Insert, Pivot Table, OK. Check the Sector, Customer, and Revenue fields, and drag the Region field to the Columns area.

This default pivot table contains several annoying items that you might want to change quickly:

- The default table style uses no gridlines, which makes it difficult to follow the rows and columns across and down.
- Numbers in the Values area are in a general number format. There are no commas, currency symbols, and so on.
- For sparse data sets, many blanks appear in the Values area. The blank cell in B5 indicates that there were no Associations sales in the Midwest. Most people prefer to see zeros instead of blanks.
- Excel renames fields in the Values area with the unimaginative name Sum of Revenue. You can change this name.

You can correct each of these annoyances with just a few mouse clicks. The following sections address each issue.
Excel MVP Debra Dalgleish sells a Pivot Power Premium add-in that fixes most of the issues listed here. This add-in is great if you will be creating pivot tables frequently. For more information, visit http://mrx.cl/pivpow16.

**Applying a Table Style to Restore Gridlines**

The default pivot table layout contains no gridlines and is rather plain. Fortunately, you can apply a table style. Any table style that you choose is better than the default.

Follow these steps to apply a table style:

1. Make sure that the active cell is in the pivot table.
2. From the ribbon, select the Design tab. Three arrows appear at the right side of the PivotTable Style gallery.
3. Click the bottom arrow to open the complete gallery, which is shown in Figure 3.2.

![Figure 3.2](image)

The gallery contains 85 styles to choose from.

4. Choose any style other than the first style from the drop-down. Styles toward the bottom of the gallery tend to have more formatting.
5. Select the check box for Banded Rows to the left of the PivotTable Styles gallery. This draws gridlines in light styles and adds row stripes in dark styles.

It does not matter which style you choose from the gallery; any of the 84 other styles are better than the default style.

For more details about customizing styles, see “Customizing a Pivot Table’s Appearance with Styles and Themes,” p. 60.
Changing the Number Format to Add Thousands Separators

If you have gone to the trouble of formatting your underlying data, you might expect that the pivot table will capture some of this formatting. Unfortunately, it does not. Even if your underlying data fields were formatted with a certain numeric format, the default pivot table presents values formatted with a general format. As a sign of some progress, when you create pivot tables from PowerPivot, you can specify the number format for a field before creating the pivot table. This functionality has not come to regular pivot tables yet.

You will be tempted to format the numbers using the right-click menu and choosing Number Format. This is not the best way to go. You will be tempted to format the cells using the tools on the Home tab. This is not the way to go. Either of these methods temporarily fixes the problem, but you lose the formatting as soon as you move a field in the pivot table. The right way to solve the problem is to use the Number Format button in the Value Field Settings dialog.

For example, in the figures in this chapter, the numbers are in the thousands or tens of thousands. At this level of sales, you would normally have a thousands separator and probably no decimal places. Although the original data had a numeric format applied, the pivot table routinely formats your numbers in an ugly general style.

You have three ways to get to this dialog:

- Right-click a number in the Values area of the pivot table and select Value Field Settings.
- Click the drop-down to the right of the Sum of Revenue field in the areas of the PivotTable Fields list and then select Value Field Settings from the context menu.
- Select any cell in the Values area of the pivot table. From the Analyze tab, select Field Settings from the Active Field group.

As shown in Figure 3.3, the Value Field Settings dialog is displayed. To change the numeric format, click the Number Format button in the lower-left corner.
In the Format Cells dialog that appears, you can choose any built-in number format or choose a custom format. For example, you can choose Currency, as shown in Figure 3.4.

**NOTE**
Although Excel 2016 offers a Live Preview feature for many formatting settings, the Format Cells dialog does not offer one. To see the changes, you must assign the number format, close the Format dialog, and then close the Value Field Settings dialog.

**Replacing Blanks with Zeros**
One of the elements of good spreadsheet design is that you should never leave blank cells in a numeric section of a worksheet. Even Microsoft believes in this rule; if your source data for a pivot table contains one million numeric cells and one blank cell, Excel 2016 treats the entire column as if it is text and chooses to count the column instead of sum it. This is why it is incredibly annoying that the default setting for a pivot table leaves many blanks in the Values area of some pivot tables.
A blank tells you that there were no sales for a particular combination of labels. In the default view, an actual zero is used to indicate that there was activity, but the total sales were zero. This value might mean that a customer bought something and then returned it, resulting in net sales of zero. Although there are limited applications in which you need to differentiate between having no sales and having net zero sales, this seems rare. In 99% of the cases, you should fill in the blank cells with zeros.

Follow these steps to change this setting for the current pivot table:

1. Right-click any cell in the pivot table and choose PivotTable Options.
2. On the Layout & Format tab in the Format section, type 0 next to the field labeled For Empty Cells Show (see Figure 3.5).
3. Click OK to accept the change.

The result is that the pivot table is filled with zeros instead of blanks, as shown in Figure 3.6.
Changing a Field Name

Every field in a final pivot table has a name. Fields in the row, column, and filter areas inherit their names from the heading in the source data. Fields in the data section are given names such as Sum of Revenue. In some instances, you might prefer to print a different name in the pivot table. You might prefer Total Revenue instead of the default name. In these situations, the capability to change your field names comes in quite handy.

To change a field name in the Values area, follow these steps:

1. Select a cell in the pivot table that contains the appropriate type of value. You might have a pivot table with both Sum of Quantity and Sum of Revenue in the Values area. Choose a cell that contains a Sum of Revenue value.
2. Go to the Analyze tab in the ribbon. A Pivot Field Name text box appears below the heading Active Field. The box currently contains Sum of Revenue.
3. Type a new name in the box, as shown in Figure 3.7. Click a cell in your pivot table to complete the entry, and have the heading in A3 change. The name of the field title in the Values area also changes to reflect the new name.

Figure 3.7
The name typed in the Custom Name box appears in the pivot table. Although names should be unique, you can trick Excel into accepting a name that’s similar to an existing name by adding a space to the end of it.

One common frustration occurs when you would like to rename Sum of Revenue to Revenue. The problem is that this name is not allowed because it is not unique; you already have a Revenue field in the source data. To work around this limitation, you can name the field and add a space to the end of the name. Excel considers “Revenue” (with a space) to be different from “Revenue” (with no space). Because this change is only cosmetic, the readers of your spreadsheet do not notice the space after the name.
Making Report Layout Changes

Excel 2016 offers three report layout styles. The Excel team continues to offer the newer Compact layout as the default report layout, even though I continually hound them about the fact that people who work in the real world would rather use the Tabular report layout, or at least would like to have a choice about which one to use as a default.

If you consider three report layouts, and the ability to show subtotals at the top or bottom, plus choices for blank rows and Repeat All Item Labels, you have 16 different layout possibilities available.

Layout changes are controlled in the Layout group of the Design tab, as shown in Figure 3.8. This group offers four icons:

- **Subtotals**—Moves subtotals to the top or bottom of each group or turns them off.
- **Grand Totals**—Turns the grand totals on or off for rows and columns.
- **Report Layout**—Uses the Compact, Outline, or Tabular forms. Offers an option to repeat item labels.
- **Blank Rows**—Inserts or removes blank lines after each group.

Using the Compact Layout

By default, all new pivot tables use the Compact layout that you saw in Figure 3.6. In this layout, multiple fields in the row area are stacked in column A. Note in the figure that the Consultants sector and the Andrew Spain Consulting customer are both in column A.
The Compact form is suited for using the Expand and Collapse icons. If you select one of the Sector value cells such as Associations in A5 and then click the Collapse Field icon on the Analyze tab, Excel hides all the customer details and shows only the sectors, as shown in Figure 3.9.

After a field is collapsed, you can show detail for individual items by using the plus icons in column A, or you can click Expand Field on the Analyze tab to see the detail again.

**TIP**

If you select a cell in the innermost row field and click Expand Field on the Options tab, Excel displays the Show Detail dialog, as shown in Figure 3.10, to enable you to add a new innermost row field.
Using the Outline Layout

When you select Design, Layout, Report Layout, Show in Outline Form, Excel puts each row field in a separate column. The pivot table shown in Figure 3.11 is one column wider, with revenue values starting in C instead of B. This is a small price to pay for allowing each field to occupy its own column. Soon, you will find out how to convert a pivot table to values so you can further sort or filter. When you do this, you will want each field in its own column.

The Excel team added the Repeat All Item Labels option to the Report Layout tab starting in Excel 2010. This alleviated a lot of busy work because it takes just two clicks to fill in all the blank cells along the outer row fields. Choosing to repeat the item labels causes values to appear in cells A6:A7, A9:A10, and A12:A15 in Figure 3.11.

Figure 3.11 shows the same pivot table from before, now in Outline form and with labels repeated.

This layout is suitable if you plan to copy the values from the pivot table to a new location for further analysis. Although the Compact layout offers a clever approach by squeezing multiple fields into one column, it is not ideal for reusing the data later.

By default, both the Compact and Outline layouts put the subtotals at the top of each group. You can use the Subtotals drop-down on the Design tab to move the totals to the
bottom of each group, as shown in Figure 3.12. In Outline view, this causes a not-really-useful heading row to appear at the top of each group. Cell A5 contains “Associations” without any additional data in the columns to the right. Consequently, the pivot table occupies 44 rows instead of 37 rows because each of the 7 sector categories has an extra header.

**Figure 3.12**
With subtotals at the bottom of each group, the pivot table occupies several more rows.

**Using the Traditional Tabular Layout**
Figure 3.13 shows the Tabular layout. This layout is similar to the one that has been used in pivot tables since their invention through Excel 2003. In this layout, the subtotals can never appear at the top of the group. The new Repeat All Item Labels works with this layout, as shown in Figure 3.13.

**Figure 3.13**
The Tabular layout is similar to pivot tables in legacy versions of Excel.

The Tabular layout is the best layout if you expect to use the resulting summary data in a subsequent analysis. If you wanted to reuse the table in Figure 3.13, you would do additional “flattening” of the pivot table by choosing Subtotals, Do Not Show Subtotals and Grand Totals, Off for Rows and Columns.
CASE STUDY: CONVERTING A PIVOT TABLE TO VALUES

Say that you want to convert the pivot table shown in Figure 3.13 to be a regular data set that you can sort, filter, chart, or export to another system. You don’t need the Sectors totals in rows 7, 14, 18, and so on. You don’t need the Grand Total at the bottom. And, depending on your future needs, you might want to move the Region field from the Columns area to the Rows area. This would allow you to add Cost and Profit as new columns in the final report.

Finally, you want to convert from a live pivot table to static values. To make these changes, follow these steps:

1. Select any cell in the pivot table.
2. From the Design tab, select Grand Totals, Off for Rows and Columns.
4. Drag the Region tile from the Columns area in the PivotTable Fields list. Drop this field between Sector and Customer in the Rows area.
5. Check Profit and Cost in the top of the PivotTable Fields list. Because both fields are numeric, they move to the Values area and appear in the pivot table as new columns. Rename both fields using the Current Field box on the Analyze tab. The report is now a contiguous solid block of data, as shown in Figure 3.14.

Figure 3.14
The pivot table now contains a solid block of data.

6. Select one cell in the pivot table. Press Ctrl+* to select all the data in the pivot table.
7. Press Ctrl+C to copy the data from the pivot table.
8. Select a blank section of a worksheet.
9. Right-click and choose Paste Values to open the fly-out menu. Select Paste Values and Number Formatting, as shown in Figure 3.15. Excel pastes a static copy of the report to the worksheet.

Figure 3.15
Use Paste Values to create a static version of the data.

Paste Values and Number Formatting
10. If you no longer need the original pivot table, select the entire pivot table and press the Delete key to clear the cells from the pivot table and free up the area of memory that was holding the pivot table cache. The result is a solid block of summary data. These 27 rows are a summary of the 500+ rows in the original data set, but they also are suitable for exporting to other systems.

Controlling Blank Lines, Grand Totals, and Other Settings

Additional settings on the Design tab enable you to toggle various elements.

The Blank Rows drop-down offers the choice Insert Blank Row After Each Item. This setting applies only to pivot tables with two or more row fields. Blank rows are not added after each item in the inner row field. You see a blank row after each group of items in the outer row fields. As shown in Figure 3.16, the blank row after each region makes the report easier to read. However, if you remove Sector from the report, you have only Region in the row fields, and no blank rows appear (see Figure 3.17).

Figure 3.16
The Blank Rows setting makes the report easier to read.

<table>
<thead>
<tr>
<th>Total Revenue</th>
<th>Customer</th>
<th>Product</th>
<th>Doodads</th>
<th>Gadget</th>
<th>Gizmo</th>
<th>Widget</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>Association</td>
<td>Association for Computers &amp; Taxation</td>
<td>$0</td>
<td>$4,270</td>
<td>$22,958</td>
<td>$7,136</td>
</tr>
<tr>
<td>6</td>
<td>IMIA Houston Chapter</td>
<td></td>
<td>$0</td>
<td>$18,064</td>
<td>$18,072</td>
<td>$15,104</td>
</tr>
<tr>
<td>7</td>
<td>Associations Total</td>
<td></td>
<td>$0</td>
<td>$22,344</td>
<td>$41,030</td>
<td>$22,940</td>
</tr>
<tr>
<td>9</td>
<td>Consultants</td>
<td>Andrew Spain Consulting</td>
<td>$0</td>
<td>$294,198</td>
<td>$288,409</td>
<td>$276,847</td>
</tr>
<tr>
<td>10</td>
<td>Consultants</td>
<td>Cambia Factor</td>
<td>$0</td>
<td>$16,784</td>
<td>$35,200</td>
<td>$5,532</td>
</tr>
</tbody>
</table>

Figure 3.17
Blank rows will not appear when there is only one item in the row field.

<table>
<thead>
<tr>
<th>Total Revenue</th>
<th>Product</th>
<th>Doodads</th>
<th>Gadget</th>
<th>Gizmo</th>
<th>Widget</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>599CD.com</td>
<td></td>
<td>$0</td>
<td>$185,675</td>
<td>$245,491</td>
</tr>
<tr>
<td>6</td>
<td>Andrew Spain Consulting</td>
<td></td>
<td>$0</td>
<td>$104,198</td>
<td>$283,498</td>
</tr>
<tr>
<td>7</td>
<td>Association for Computers &amp; Taxation</td>
<td></td>
<td>$0</td>
<td>$4,270</td>
<td>$22,958</td>
</tr>
<tr>
<td>8</td>
<td>Bits of Confetti</td>
<td></td>
<td>$28,663</td>
<td>$2,358</td>
<td>$0</td>
</tr>
<tr>
<td>9</td>
<td>Cambia Factor</td>
<td></td>
<td>$0</td>
<td>$16,784</td>
<td>$35,200</td>
</tr>
<tr>
<td>10</td>
<td>Construction Intelligence &amp; Analytics, Inc.</td>
<td></td>
<td>$6,038</td>
<td>$18,552</td>
<td>$17,728</td>
</tr>
<tr>
<td>11</td>
<td>CPAOutSider Study</td>
<td></td>
<td>$0</td>
<td>$130,533</td>
<td>$280,936</td>
</tr>
<tr>
<td>12</td>
<td>Data2Impact</td>
<td></td>
<td>$9</td>
<td>$26,484</td>
<td>$13,544</td>
</tr>
<tr>
<td>13</td>
<td>Excel4Apps</td>
<td></td>
<td>$0</td>
<td>$233,435</td>
<td>$285,761</td>
</tr>
</tbody>
</table>
Chapter 3              Customizing a Pivot Table

Grand totals can appear at the bottom of each column and/or at the end of each row, or they can be turned off altogether. Settings for grand totals appear in the Grand Totals drop-down of the Layout group on the Design tab. The wording in this drop-down is a bit confusing, so Figure 3.18 shows what each option provides. The default is to show grand totals for rows and columns, as in Figure 3.17.

NOTE

For those of you following along with the sample files, you may have noticed quite a leap from the pivot table in Figure 3.14 to the one in Figure 3.16, but it is still the same pivot table. Here is how to make the changes:

1. Uncheck Sector, Customer, Profit, and Cost in the Pivot Table Fields list.
2. Drag the Product field to the Columns area.
3. Recheck the Sector field to move it to the second Row field.
4. Make sure the active cell is in column A.
5. On the Design tab of the ribbon, open Subtotals and choose Show All Subtotals at the Bottom of the Group.
6. As shown in Figure 3.16, open the Blank Rows drop-down and choose Insert Blank Row After Each Item.
7. To get to the pivot table shown in Figure 3.17, uncheck the Sector field.

For those of you following along with the sample files, you may have noticed quite a leap from the pivot table in Figure 3.14 to the one in Figure 3.16, but it is still the same pivot table. Here is how to make the changes:

1. Uncheck Sector, Customer, Profit, and Cost in the Pivot Table Fields list.
2. Drag the Product field to the Columns area.
3. Recheck the Sector field to move it to the second Row field.
4. Make sure the active cell is in column A.
5. On the Design tab of the ribbon, open Subtotals and choose Show All Subtotals at the Bottom of the Group.
6. As shown in Figure 3.16, open the Blank Rows drop-down and choose Insert Blank Row After Each Item.
7. To get to the pivot table shown in Figure 3.17, uncheck the Sector field.

Grand totals can appear at the bottom of each column and/or at the end of each row, or they can be turned off altogether. Settings for grand totals appear in the Grand Totals drop-down of the Layout group on the Design tab. The wording in this drop-down is a bit confusing, so Figure 3.18 shows what each option provides. The default is to show grand totals for rows and columns, as in Figure 3.17.
If you want a grand total column but no grand total at the bottom, choose On for Rows Only, as shown at the top of Figure 3.18. To me, this seems backward. To keep the grand total column, you have to choose to turn on grand totals for rows only. I guess the rationale is that each cell in F5:F8 is a grand total of the row to the left of the cell. Hence, you are showing the grand totals for all the rows but not for the columns. Perhaps someday Microsoft will ship a version of Excel in English-Midwest where this setting would be called “Keep the Grand Total Column.” But for now, it remains confusing.

In a similar fashion, to show a grand total row but no grand total column, you open the Grand Totals menu and choose On for Columns Only. Again, in some twisted version of the English language, cell B18 is totaling the cells in the column above it.

The final choice, Off for Rows and Columns, is simple enough. Excel shows neither a grand total column nor a grand total row.

Back in Excel 2003, pivot tables were shown in Tabular layout and logical headings such as Region and Product would appear in the pivot table, as shown in the top pivot table in Figure 3.19. When the Excel team switched to Compact form, they replaced those headings with Row Labels and Column Labels. These add nothing to the report. To toggle off those headings, look on the far right side of the Analyze tab for an icon called Field Headers and click it to remove Row Labels and Column Labels from your pivot tables in Compact form.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Tabular Form</td>
<td>Revenue Product</td>
<td>Doodads</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Region</td>
<td>Product</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Midwest</td>
<td>$6,036</td>
<td>$544,772</td>
<td>$652,651</td>
<td>$537,965</td>
</tr>
<tr>
<td>4</td>
<td>Northeast</td>
<td>$38,860</td>
<td>$714,009</td>
<td>$751,724</td>
<td>$620,019</td>
</tr>
<tr>
<td>5</td>
<td>South</td>
<td>$0</td>
<td>$839,551</td>
<td>$913,589</td>
<td>$844,186</td>
</tr>
<tr>
<td>6</td>
<td>West</td>
<td>$28,663</td>
<td>$65,382</td>
<td>$70,057</td>
<td>$75,349</td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Compact Form - “Region” becomes “Row Labels”</td>
<td>Revenue Column Labels</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Midwest</td>
<td>$6,036</td>
<td>$544,772</td>
<td>$652,651</td>
<td>$537,965</td>
</tr>
<tr>
<td>10</td>
<td>Northeast</td>
<td>$38,860</td>
<td>$714,009</td>
<td>$751,724</td>
<td>$620,019</td>
</tr>
<tr>
<td>11</td>
<td>South</td>
<td>$0</td>
<td>$839,551</td>
<td>$913,589</td>
<td>$844,186</td>
</tr>
<tr>
<td>12</td>
<td>West</td>
<td>$28,663</td>
<td>$65,382</td>
<td>$70,057</td>
<td>$75,349</td>
</tr>
<tr>
<td>13</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Compact Form - Toggle Off Field Headers</td>
<td>Revenue</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Midwest</td>
<td>$6,036</td>
<td>$544,772</td>
<td>$652,651</td>
<td>$537,965</td>
</tr>
<tr>
<td>16</td>
<td>Northeast</td>
<td>$38,860</td>
<td>$714,009</td>
<td>$751,724</td>
<td>$620,019</td>
</tr>
<tr>
<td>17</td>
<td>South</td>
<td>$0</td>
<td>$839,551</td>
<td>$913,589</td>
<td>$844,186</td>
</tr>
<tr>
<td>18</td>
<td>West</td>
<td>$28,663</td>
<td>$65,382</td>
<td>$70,057</td>
<td>$75,349</td>
</tr>
<tr>
<td>19</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>Doodads</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>Midwest</td>
<td>$6,036</td>
<td>$544,772</td>
<td>$652,651</td>
<td>$537,965</td>
</tr>
<tr>
<td>22</td>
<td>Northeast</td>
<td>$38,860</td>
<td>$714,009</td>
<td>$751,724</td>
<td>$620,019</td>
</tr>
<tr>
<td>23</td>
<td>South</td>
<td>$0</td>
<td>$839,551</td>
<td>$913,589</td>
<td>$844,186</td>
</tr>
<tr>
<td>24</td>
<td>West</td>
<td>$28,663</td>
<td>$65,382</td>
<td>$70,057</td>
<td>$75,349</td>
</tr>
</tbody>
</table>
When you arrange several pivot tables vertically, as in Figure 3.19, you'll notice that changes in one pivot table change the column widths for the entire column, often causing ### to appear in the other pivot tables. By default, Excel changes the column width to AutoFit the pivot table but ignores anything else in the column. To turn off this default behavior, right-click each pivot table and choose PivotTable Options. In the first tab of the Options dialog, the second-to-last check box is AutoFit Column Widths on Update. Uncheck this box.

**CAUTION**

Customizing a Pivot Table's Appearance with Styles and Themes

You can quickly apply color and formatting to a pivot table report by using the 85 built-in styles in the PivotTable Styles gallery on the Design tab. These 85 styles are further modified by the four check boxes to the left of the gallery. Throw in the 48 themes on the Page Layout tab, and you have 65,280 easy ways to format a pivot table. If none of those provide what you need, you can define a new style.

Start with the four check boxes in the PivotTable Style Options group of the Design tab of the ribbon. You can choose to apply special formatting to the row headers, column headers, banded rows, or banded columns. My favorite choice here is banded rows because it makes it easier for the reader's eye to follow a row across a wide report. You should choose from these settings first because the choices here will modify the thumbnails shown in the Styles gallery.

As mentioned earlier, the PivotTable Styles gallery on the Design tab offers 85 built-in styles. Grouped into 28 styles each of Light, Medium, and Dark, the gallery offers variations on the accent colors used in the current theme. In Figure 3.20, you can see which styles in the gallery truly support banded rows and which just offer a bottom border between rows.

**Figure 3.20**
The styles are shown here with accents for row headers, column headers, and alternating colors in the columns.

**TIP**

Note that you can modify the thumbnails for the 85 styles shown in the gallery by using the four check boxes in the PivotTable Style Options group.
Customizing a Pivot Table's Appearance with Styles and Themes

The Live Preview feature in Excel 2016 works in the Styles gallery. As you hover your mouse cursor over style thumbnails, the worksheet shows a preview of the style.

**Customizing a Style**

You can create your own pivot table styles, and the new styles are added to the gallery for the current workbook only. To use the custom style in another workbook, copy and temporarily paste the formatted pivot table to the other workbook. After the pivot table has been pasted, apply the custom style to an existing pivot table in your workbook and then delete the temporary pivot table.

Say that you want to create a pivot table style in which the banded colors are three rows high. Follow these steps to create the new style:

1. Find an existing style in the PivotTable Styles gallery that supports banded rows. Right-click the style in the gallery and select Duplicate. Excel displays the Modify PivotTable Quick Style dialog.
2. Choose a new name for the style. Excel initially appends a 2 to the existing style name, which means you have a name such as PivotStyleDark3 2. Type a better name, such as Greenbar.
3. In the Table Element list, click First Row Stripe. A new section called Stripe Size appears in the dialog.
4. Select 3 from the Stripe Size drop-down, as shown in Figure 3.21.

![Figure 3.21](image)

*Customize the style in the Modify PivotTable Style dialog.*
5. To change the stripe color, click the Format button. The Format Cells dialog appears. Click the Fill tab and then choose a fill color. If you want to be truly authentic, choose More Colors, Custom and use Red=200, Green=225, Blue=204 to simulate 1980s-era greenbar paper. Click OK to accept the color and return to the Modify PivotTable Quick Style dialog.

6. In the Table Element List, click Second Row Stripe. Select 3 from the Stripe Size drop-down. Modify the format to use a lighter color, such as white.

7. If you plan on creating more pivot tables in this workbook, choose the Set as Default PivotTable Style for This Document check box in the lower left.

8. Optionally edit the colors for Header Row and Grand Total Row.

9. Click OK to finish building the style. Strangely, Excel doesn’t automatically apply this new style to the pivot table. After you put in a few minutes of work to tweak the style, the pivot table does not change.

10. Your new style should be the first thumbnail visible in the styles gallery. Click that style to apply it to the pivot table.

**TIP**

If you have not added more than seven custom styles, the thumbnail should be visible in the closed gallery, so you can choose it without reopening the gallery.

### Modifying Styles with Document Themes

The formatting options for pivot tables in Excel 2016 are impressive. The 84 styles combined with 16 combinations of the Style options make for hundreds of possible format combinations.

In case you become tired of these combinations, you can visit the Themes drop-down on the Page Layout tab, where many built-in themes are available. Each theme has a new combination of accent colors, fonts, and shape effects.

To change a document theme, open the Themes drop-down on the Page Layout tab. Choose a new theme, and the colors used in the pivot table change to match the theme.

**CAUTION**

Changing the theme affects the entire workbook. It changes the colors and fonts and affects all charts, shapes, tables, and pivot tables on all worksheets of the active workbook. If you have several other pivot tables in the workbook, changing the theme will apply new colors to all of the pivot tables.

**TIP**

Some of the themes use unusual fonts. You can apply the colors from a theme without changing the fonts in your document by using the Colors drop-down next to the Themes menu, as shown in Figure 3.22.
Changing Summary Calculations

When you create a pivot table report, by default Excel summarizes the data by either counting or summing the items. Instead of Sum or Count, you might want to choose functions such as Min, Max, and Count Numeric. In all, 11 options are available. However, the common reason to change a summary calculation is that Excel has incorrectly chosen to count instead of sum your data.

Understanding Why One Blank Cell Causes a Count

If all the cells in a column contain numeric data, Excel chooses to sum. If just one cell is either blank or contains text, Excel chooses to count.

In Figure 3.23, the worksheet contains mostly numeric entries but has a single blank cell in G2. The one blank cell is enough to cause Excel to count the data instead of summing.
In Excel 2016, the first clue that you have a problem appears when you select the Revenue check box in the top section of the PivotTable Fields list. If Excel moves the Revenue field to the Rows area, you know that Excel considers the field to be text instead of numeric.

**CAUTION**
Be vigilant while dragging fields into the Values area. If a calculation appears to be dramatically low, check to see if the field name reads Count of Revenue instead of Sum of Revenue.

When you create the pivot table in Figure 3.24, you should notice that your company has only $562 in revenue instead of millions. This should be a hint that the heading in B3 reads Count of Revenue instead of Sum of Revenue. In fact, 562 is one less than the number of records in the data set; Excel doesn’t include the blank cell in the Count function.

To override the incorrect Count calculation, right-click any pivot table cell in the Revenue column. Choose Summarize Values By and then choose Sum (see Figure 3.25).

**Figure 3.24**
Your revenue numbers look anemic. Notice in cell B3 that Excel chose to count instead of sum the revenue. This often happens if you inadvertently have one blank cell in your Revenue column.

**Figure 3.25**
Change the function from Count to Sum in the Summarize Values By drop-down.
Using Functions Other Than Count or Sum

The settings for Summarize Values By and Show Values As were temporarily promoted to drop-downs in the Excel 2010 ribbon, but they are not in the ribbon in Excel 2016. All of the pivot table calculations icons for the Quick Access Toolbar were removed from Excel 2013 and are still gone in 2016. They were apparently removed to make space for Insert Timeline, Drill Down, Drill Up, and Recommended Pivot Tables. If you were a fan of Summarize Values By and Show Values As, you can continue to use them from the right-click menu or by selecting a cell and pressing Shift+F10. These options have always been available in the Value Field Settings dialog.

Excel offers six functions through the Summarize Values By command, plus five more options when you select More Options. The options available are as follows:

- **Sum**—Provides a total of all numeric data.
- **Count**—Counts all cells, including numeric, text, and error cells. This is equivalent to the Excel function `=COUNTA()`.  
- **Average**—Provides an average.
- **Max**—Shows the largest value.
- **Min**—Shows the smallest value.
- **Product**—Multiplies all the cells together. For example, if your data set has cells with values of 3, 4, and 5, the product is 60.
- **Count Nums**—Counts only the numeric cells. This is equivalent to the Excel function `=COUNT()`.  
- **StdDev and StdDevP**—Calculate the standard deviation. Use StdDevP if your data set contains the complete population. Use StdDev if your data set contains a sample of the population.
- **Var and VarP**—Calculate the statistical variance. Use VarP if your data contains a complete population. If your data contains only a sampling of the complete population, use Var to estimate the variance.

**NOTE**

Standard deviations explain how tightly results are grouped around the mean.

Adding and Removing Subtotals

Subtotals are an essential feature of pivot table reporting. Sometimes you might want to suppress the display of subtotals, and other times you might want to show more than one subtotal per field.
Suppressing Subtotals with Many Row Fields

When you have many row fields in a report, subtotals can obscure your view. For example, in Figure 3.26, there is no need to show subtotals for each market because there is only one sales rep for each market.

If you used the Subtotals drop-down on the Design tab, you would turn off all subtotals, including the Region subtotals and the Market subtotals. The Region subtotals are still providing good information, so you want to use the Subtotals setting in the Field Settings dialog. Choose one cell in the Market column. On the Analyze tab, choose Field Settings. Change the Subtotals setting from Automatic to None (see Figure 3.27).

To remove subtotals for the Market field, click the Market field in the bottom section of the PivotTable Fields list. Select Field Settings. In the Field Settings dialog, select None under Subtotals, as shown in Figure 3.27.
Adding Multiple Subtotals for One Field

You can add customized subtotals to a row or column label field. Select the Region field in the bottom of the PivotTable Fields list, and select Field Settings.

In the Field Settings dialog for the Region field, select Custom and then select the types of subtotals you would like to see. The dialog in Figure 3.28 shows five custom subtotals selected for the Region field. It is rare to see pivot tables use this setting. It is not perfect. Note that the count of 211 records automatically gets a currency format like the rest of the column, even though this is not a dollar figure. Also, the average of $12,333 for South is an average of the detail records, not an average of the individual market totals.

Figure 3.28
By selecting the Custom option in the Subtotals section, you can specify multiple subtotals for one field.

TIP
If you need to calculate the average of the four regions, you can do it with the DAX formula language and PowerPivot. See Chapter 10.

Changing the Calculation in a Value Field

The Value Field Settings dialog offers 11 options on the Summarize Values As tab and 15 main options on the Show Values As tab. The options on the first tab are the basic Sum, Average, Count, Max, and Min options that are ubiquitous throughout Excel; the 15 options under Show Values As are interesting ones such as % of Total, Running Total, and Ranks.

For Excel 2010 only, these options appeared as two drop-down menus in the ribbon. They are not on the Excel 2016 ribbon, but they still exist in the right-click menu. Because many of the calculations require one or two additional settings, you end up back in an extra dialog.
anyway. If you get in the habit of using the Value Field Settings dialog, you will have access
to all the settings in one dialog.

Six of the Show Values As calculations were introduced in Excel 2010, including % of
Parent Item, Rank, and % Running Total In.

The following examples show how to use the various calculation options. To contrast
the settings, you can build a pivot table where you drag the Revenue field to the Values
area nine separate times. Each one shows up as a new column in the pivot table. Over the
course of the rest of the chapter, you will see the settings required for the calculations in
each column.

To change the calculation for a field, select one value cell for the field and click the Field
Settings button on the Analyze tab of the ribbon. The Value Field Settings dialog is simi-
lar to the Field Settings dialog, but it has two tabs. The first tab, Summarize Values By,
contains Sum, Count, Average, Max, Min, Product, Count Numbers, StdDev, StdDevP,
Var, and VarP. You can choose 1 of these 11 calculation options to change the data in the
column. In Figure 3.29, columns B through D show various settings from the Summarize
Values By tab.
Changing the Calculation in a Value Field

Counting distinct items has been difficult in pivot tables but is now easier using Power Pivot. See Chapter 10 for more details.

Far more interesting options appear on the Show Values As tab of the Value Field Settings dialog, as shown in Figure 3.30. Fifteen options appear in the drop-down. Depending on the option you choose, you might need to specify either a base field or a base field and a base item. Columns E through J in Figure 3.29 show some of the calculations possible using Show Values As.

Table 3.1 summarizes the Show Values As options.
### Table 3.1  Calculations in Show Value As

<table>
<thead>
<tr>
<th>Show Value As</th>
<th>Additional Required Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Calculation</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>% of Grand Total</td>
<td>None</td>
<td>Shows percentages so all the detail cells in the pivot table total 100%</td>
</tr>
<tr>
<td>% of Column Total</td>
<td>None</td>
<td>Shows percentages that total up and down the pivot table to 100%</td>
</tr>
<tr>
<td>% of Row Total</td>
<td>None</td>
<td>Shows percentages that total across the pivot table to 100%</td>
</tr>
<tr>
<td>% of Parent Row Total</td>
<td>None</td>
<td>With multiple row fields, shows a percentage of the parent item's total row</td>
</tr>
<tr>
<td>% of Parent Column Total</td>
<td>None</td>
<td>With multiple column fields, shows a percentage of the parent column's total</td>
</tr>
<tr>
<td>Index</td>
<td>None</td>
<td>Calculates the relative importance of items</td>
</tr>
<tr>
<td>% of Parent Total</td>
<td>Base Field only</td>
<td>With multiple row and/or column fields, calculates a cell's percentage of the parent item's total</td>
</tr>
<tr>
<td>Running Total In</td>
<td>Base Field only</td>
<td>Calculates a running total</td>
</tr>
<tr>
<td>% Running Total In</td>
<td>Base Field only</td>
<td>Calculates a running total as a percentage of the total</td>
</tr>
<tr>
<td>Rank Smallest to Largest</td>
<td>Base Field only</td>
<td>Provides a numeric rank, with 1 as the smallest item</td>
</tr>
<tr>
<td>Rank Largest to Smallest</td>
<td>Base Field only</td>
<td>Provides a numeric rank, with 1 as the largest item</td>
</tr>
<tr>
<td>% of</td>
<td>Base Field and Base Item</td>
<td>Expresses the values for one item as a percentage of another item</td>
</tr>
<tr>
<td>Difference From</td>
<td>Base Field and Base Item</td>
<td>Shows the difference of one item compared to another item or to the previous item</td>
</tr>
<tr>
<td>% Difference From</td>
<td>Base Field and Base Item</td>
<td>Shows the percentage difference of one item compared to another item or to the previous item</td>
</tr>
</tbody>
</table>

The capability to create custom calculations is another example of the unique flexibility of pivot table reports. With the Show Data As setting, you can change the calculation for a particular data field to be based on other cells in the Values area.

The following sections illustrate a number of Show Values As options.

### Showing Percentage of Total

In Figure 3.29, column E shows % of Total. Jade Miller, with $2.1 million in revenue, represents 31.67% of the $6.7 million total revenue. Column E uses % of Column Total on the Show Values As tab. Two other similar options are % of Row Total and % of Grand Total.
Choose one of these based on whether your text fields are going down the report, across the report, or both down and across.

**Using % Of to Compare One Line to Another Line**

The % Of option enables you to compare one item to another item. For example, in the current data set, Anne was the top sales rep in the previous year. Column F shows everyone’s sales as a percentage of Anne’s. Cell E7 in Figure 3.31 shows that Jeff’s sales were almost 58% of Anne’s sales.

**Figure 3.31**
This report is created using the % Of option with Anne Troy as the Base Item.

To set up this calculation, choose Show Values As, % Of. For Base Field, choose Rep because this is the only field in the Rows area. For Base Item, choose Anne Troy. The result is shown in Figure 3.31.

**Showing Rank**

Two ranking options are available. Column G in Figure 3.32 shows Rank Largest to Smallest. Jade Miller is ranked #1, and Sabine Hanschitz is #12. A similar option is Rank Smallest to Largest, which would be good for the pro golf tour.

**Figure 3.32**
The Rank options were added in Excel 2010.
To set up a rank, choose Value Field Settings, Show Values As, Rank Largest to Smallest. You are required to choose base field. In this example, because Rep is the only row field, it is the selection under Base Field.

These rank options show that pivot tables have a strange way of dealing with ties. I say strange because they do not match any of the methods already established by the Excel functions =RANK(), =RANK.AVG(), and =RANK.EQ(). For example, if the top two markets have a tie, they are both assigned a rank of 1, and the third market is assigned a rank of 2.

### Tracking Running Total and Percentage of Running Total

Running total calculations are common in reports where you have months running down the column or when you want to show that the top \(N\) customers make up \(N\%\) of the revenue. The Running Total In calculation has been in Excel for many versions. The \% Running Total In setting was added in Excel 2010.

In Figure 3.33, cell I8 shows that the top four sales reps account for 76.97\% of the total sales.

![Figure 3.33](image)

To produce this figure, you have to use the Sort feature, which is discussed in depth in Chapter 4, “Grouping, Sorting, and Filtering Pivot Data.” To create a similar analysis with the sample file, go to the drop-down in A4 and choose More Sort Options, Descending, by Total. Also note that the \% Change From calculation shown in the next example is not compatible with sorting.
Changing the Calculation in a Value Field

To specify Running Total In (as shown in Column H) or % Running Total In (Column J), select Field Settings, Show Values As, Running Total In. You have to specify a base field, which in this case is the row field: Rep.

Displaying a Change from a Previous Field

Figure 3.34 shows the % Difference From setting. This calculation requires a base field and base item. You could show how each market compares to Anne Troy by specifying Anne Troy as the base item. This would be similar to Figure 3.31, except each market would be shown as a percentage of Anne Troy.

Figure 3.34
The % Difference From options enable you to compare each row to the previous or next row.

With date fields, it would make sense to use % Difference From and choose (previous) as the base item. Note that the first cell will not have a calculation because there is no previous data in the pivot table.

Tracking the Percentage of a Parent Item

The legacy % of Total settings always divides the current item by the grand total. In Figure 3.35, cell E4 says that Chicago is 2.75% of the total data set. A common question at the MrExcel.com message board is how to calculate Chicago’s revenue as a percentage of the Midwest region total. This was possible but difficult in older versions of Excel. Starting in Excel 2010, though, Excel added the % of Parent Row, % of Parent Column, and % of Parent Total options.
Chapter 3              Customizing a Pivot Table

Figure 3.35
An option in Excel enables you to calculate a percentage of the parent row.

To set up this calculation in Excel 2016, use Field Settings, Show Values As, % of Parent Row Total. Cell D4 in Figure 3.35 shows that Chicago’s $184,425 is 10.59% of the Midwest total of $1,741,424.

Although it makes sense, the calculation on the subtotal rows might seem confusing. D4:D8 shows the percentage of each market as compared to the Midwest total. The values in D9, D11, D16, and D19 compare the region total to the grand total. For example, the 31.67% in D11 says that the Northeast region’s $2.1 million is a little less than a third of the $6.7 million grand total.

Tracking Relative Importance with the Index Option
The final option, Index, creates a somewhat obscure calculation. Microsoft claims that this calculation describes the relative importance of a cell within a column. In Figure 3.36, Georgia peaches have an index of 2.55, and California peaches have an index of 0.50. This shows that if the peach crop is wiped out next year, it will be more devastating to Georgia fruit production than to California fruit production.

Figure 3.36
Using the Index function, Excel shows that peach sales are more important in Georgia than in California.
Here is the exact calculation: First, divide Georgia peaches by the Georgia total. This is
180/210, or 0.857. Next, divide total peach production (285) by total fruit production (847).
This shows that peaches have an importance ratio of 0.336. Now, divide the first ratio by
the second ratio: 0.857/0.336.

In Ohio, apples have an index of 4.91, so an apple blight would be bad for the Ohio fruit
industry.

I have to admit that, even after writing about this calculation for 10 years, there are parts
that I don’t quite comprehend. What if a state like Hawaii relied on productions of lychees,
but lychees were nearly immaterial to U.S. fruit production? If lychees were half of Hawaii’s
fruit production but 0.001 of U.S. fruit production, the Index calculation would skyrocket
to 500.

**Next Steps**

Note that the following pivot table customizations are covered in subsequent chapters:

- Sorting a pivot table is covered in Chapter 4.
- Filtering records in a pivot table is covered in Chapter 4.
- Grouping daily dates up to months or years is covered in Chapter 4.
- Adding new calculated fields is covered in Chapter 5, “Performing Calculations in
  Pivot Tables.”
- Using data visualizations and conditional formatting in a pivot table is covered in
  Chapter 4.
This page intentionally left blank
This page intentionally left blank
Index

SYMBOLS
% (percent), comparing lines with, 71
= (equal sign), 292
3D Map, 245
  bubble/pie charts, creating, 266
case studies, 271-273
column charts, formatting, 264
data over time, animating, 269
geospatial data, 262-263
graphic data, analyzing, 261-273
heat maps/region maps, applying, 266
labeling points, 266
navigating, 264-265
optimizing, 267-269
preparing data for, 261
tours, building, 270-271
videos, sharing, 271

A
Access (Microsoft), formatting pivot tables, 169-171
accessing functions, OLAP, 211-213
accounts, saving to OneDrive, 195
actions
  column-level, 185
tables, 186-188
activating classic layouts, 30
ActiveX controls, 279
activity by market, analysis of, 38
Add This Data to the Data Model option, 25
add-ins

Pivot Power Premium, 47
Power Pivot, 225
  applying, 234-238
  defining relationships, 236
  enabling, 234
  importing text, 235-236
  linking files, 236

AddFields method, 298

adding

calculated columns using DAX language, 237

calculated fields to data sources, 114
calculated items, 126
calculations to OLAP, 213-215, 222
data to Power BI, 197-198
fields, 251
  creating pivot tables with VBA, 298-299
  filters areas, 104
to reports, 26-28
Horizontal Multiples, 256
layers, 28
numeric fields to Values areas, 348-349
pages to sectors, 107
paths, 246
rank number fields, 359-360
regions, 27
slicers, 33
subtotals, 64-67, 80, 315
tables to Data Models, 163-165, 228, 346
  thousands separators, 48-49
  Timeline slicers, 36

Advanced Editor dialog box, 182

advantages of pivot tables, 11

analysis, 11, 157

Access (Microsoft), formatting, 169-171
activity by market, 38
calculations, 113
  See also calculations
cleaning up data for, 23-24
Data Models
  adding tables, 163-165
deleting tables, 165
  formatting, 158-162, 166
  limitations of internal, 167
  managing relationships, 162-163
data sets, selecting, 25
geographic data with 3D Map, 261-273
OLAP what-if-analysis, executing, 220-222

Power Query
  applying, 174-192
  connecting, 188-192
  formatting columns, 185
  formatting tables, 186-188
  managing, 183-185
  overview of, 175-180
  refreshing, 183
  steps, 181-182
  Quick Analysis option, 32
SQL Servers, formatting, 171-174

Analysis Services
  options, 204
  Tutorial cube, 205

animating scatter charts, 259-260

applying

  AutoFilter, 363
  automatic grouping, 77-85
  AutoShow, 329-332
AutoSort, 312
    calculated fields, 323-324
    calculated items, 324-325
    cells, references, 129
Compact layout, 52-53
    conceptual filters, 339-340
conditional formatting, 149-153
    constants, 129
Data Model, 345-351
Data Filters, 103-104
DAX language, 224, 239-243
drop-down lists, Areas section, 88-89
    fields to lists, 83-89
    filters areas, 104-112
    functions, 64
    heat/region maps, 3D Map, 266
    Index function, 74
macros, 275-276
    manual sequences to sorting, 92-93
    named ranges, 129
Object variables, 294-295
Outline layout, 53-54
    pivot charts, 135-136, 145-148
    pivot tables, 10-12
Power Pivot add-in, 234-238
Power Query, 174-192
    restrictions, 368-371
search filters, 342-343
slicers, 33-38, 107-109
styles, restoring gridlines, 47
Tabular layout, 55
time intelligence, 242-243
timelines, 107-110
Top 10 filter, 101-102
Visual Basic Editor, 291
    worksheet functions, 129

areas
    Columns, 12, 14, 27
    Filters, 12, 14, 27
    navigating, 12
    Rows, 12-13, 27
    Values, 12-13, 27
Areas section, drop-down lists, 88-89
assigning macros, 279
authentication (Windows Authentication), 172
AutoComplete, 292
AutoFilter, 363
automatic grouping
    applying, 77-85
    undoing, 78
AutoShow, applying, 329-332
AutoSort, applying, 312
avoiding
    GetPivotData, 376-380
    groups, repeating, 21
    section headings, storing, 20
backward compatibility, 15-17, 38
benefits of Data Models, 224-225
    See also limitations
blank cells, 23
    counts, causing, 63-64
    Data areas, filling, 301
data sources, deleting, 22
    eliminating, 311-312
    Row areas, filling, 302
    zeros, replacing, 49-50
BLANK function, 239
Blank Rows setting, 57
breaks (page), adding subtotals, 315
bubble charts, 141, 266
building. See formatting
buttons, fields, 138-139

caches, 15
  defining, 347
  overwriting, 39
  sharing, 40-41
  slicers, defining, 344
calculated columns (DAX)
  adding, 237
  applying calculations for, 239
calculated fields
  applying, 323-324
  creating, 116-123
  data sources, adding to, 114
  DAX language
    defining, 240-241
    filtering, 240
    formulas, creating with, 115
    inserting, 116
    naming, 118
    rules, 129
    summaries, 120-123
calculated items
  adding, 126
  applying, 324-325
  formatting, 124-127
  naming, 125
  rules, 131
  solve order, modifying, 132
calculations, 10, 113
  configuring, 67-75
  customizing, 116
  DAX language, applying, 239-243
  deleting, 131
  editing, 131
  fields, 114
    See also calculated fields
  groups, 325-327
  items, 124
    See also calculated items
  managing, 131-133
  measures, formatting, 214-217
  members, formatting, 217-219
OLAP (online analytical processing)
  adding, 213-222
  managing, 220
  overview of, 113-114
  percentages of parent items, 73
  pivot charts
    interactive reports, 142-144
    synchronizing, 283-287
  Power Query, transposing data sets, 190-192
  text, grouping, 82-85
  values, converting to, 55-57

Caption property, 322
case studies
  3D Map, 271-273
  analysis
    activity by market, 38
    cleaning up data for, 23-24
  calculated fields, summaries, 120-123
  Data Models, applying, 231-232
  pivot charts
    interactive reports, 142-144
    synchronizing, 283-287
  Power Query, transposing data sets, 190-192
  text, grouping, 82-85
  values, converting to, 55-57
categories, viewing, 307-319  
categorizing fields, 245  
causing counts, 63-64  
cells  
  blank. See blank cells  
  deleting, 22  
  inserting, 302  
  pivot charts, applying as source data, 147-148  
  preventing errors, 302  
  references, applying, 129  
Change PivotTable Data Source dialog box, 40  
charts  
  3D Maps, creating, 266  
  columns, formatting, 264  
  filtering, 255  
  overview of, 136  
    See also pivot charts  
  Power View  
    adding drill-down to, 251-252  
    copying, 256  
    filtering, 252  
  scatter  
    animating, 259-260  
    XY, 141  
  titles, 141  
check boxes, filtering, 96-97  
CHOOSE function. See SWITCH function  
classic layouts, activating, 30  
    See also layouts  
cleaning up data for analysis, 23-24  
closing GetPivotData, 379-380  
code  
  Data Models, generating, 349  
  object-oriented, 292-293  
  pivot tables, generating, 300  
  reports, generating, 319  
  summaries, generating, 305  
  VBA (Visual Basic for Applications)  
    applying object variables, 294-295  
    editing, 282  
    shortening, 295  
    sizing data ranges, 293-294  
Code window, 291  
Collapse Entire Field (+) button, 138  
Collapse Entire Field (-) button, 138  
colors, selecting, 63  
columns  
  areas, 12-14, 27  
  automatic grouping, applying, 77-85  
  charts, formatting, 264  
  data sources, expanding, 39  
  filtering, 96-104  
  formatting, 246  
  grand totals, viewing, 58  
  groups, avoiding repeating, 21  
  moving, 92  
  Off for Rows and Columns setting, 59  
  Power Query, formatting, 185  
  tabular layouts, 20  
commands  
  Distinct Count, 233  
  From Web, 177  
  List Formulas, 133  
  MDX Calculated Measure, 215  
  MDX Calculated Member, 218  
  Query Settings, 181  
  Share with People, 196  
  Summarize Values By, 64  
comments, 292  
Compact form, 52-53, 86  
Compact layout, 299
comparisons
- calculated items, 124
- lines with % (percent), 71
- pivot tables/Power Pivot add-in, 238-239
- tables, 361

Compatibility Checker, 16

Compatibility mode, 16

compatibility, backward. See backward compatibility

conceptual filters, applying, 339-340

conditional formatting
- applying, 153
- customizing, 152-156
- pivot charts, applying, 149-151

configuring
See also formatting
calculations, 67-75
conditional formatting, 151
Power Query, 175-180
slicers, 343-345

connecting
Data Connection Wizard, 172
databases, 171
Existing Connections dialog box, 167
OLAP (online analytical processing), 204-206
Power Query, 188-192
slicers, 35
Workbook Connections dialog box, 164

constants, applying, 129

controlling
- sort order, 312
- totals, 302-304

controls
- ActiveX, 279
- forms
  formatting interfaces with, 278-280
  inserting scrollbars, 281

Convert option, 16

Convert to Formulas option, 212

converting
- pivot tables to values, 55-57, 304-305
- ranges, 163
- tables to charts (Power View), 250-251

copying
- charts (Power View), 256
- pivot tables to workbooks, 314-315
- reports, filtering, 105-107

Count Distinct option, 224

counting
- causing, 63-64
- records, 322

Create Cube File wizard, 210

Create PivotChart dialog box, 139

Create PivotTable dialog box, 25, 159, 166, 228

Create Table dialog box, 163

CreatePivotTable method, 297

cubes
Analysis Services Tutorial, 205
functions, navigating, 212-213
naming, 211

OLAP (online analytical processing)
- accessing functions, 211-213
- adding calculations, 213-222
- connecting, 204-206
- creating offline cubes, 209-211
- limitations of, 208-209
- navigating, 207-208
Dashboards, 245

Data areas, filling blank cells, 301

Data Connection Wizard, 172, 204

Data Models, 158-167, 223

DAX language, applying, 224

DAX code, generating, 341

Dashboards

analyzing geographic data with, 261-273
building tours, 270-271
creating bubble/pie charts, 266
formatting column charts, 264
gooing data, 262-263

Data Models

applying, 345-351
benefits of, 224-225
code, generating, 349
DAX language, applying, 224
formatting, 158-162
limitations of, 225-226
See also OLAP

Data Connection Wizard

See also OLAP

Data areas, filling blank cells

Dashboards

Dashboards, 245

DAX language, applying, 224

DASH code, generating, 341

Dashboards

analyzing geographic data with, 261-273
building tours, 270-271
creating bubble/pie charts, 266
formatting column charts, 264
gooing data, 262-263

Data Models

applying, 345-351
benefits of, 224-225
code, generating, 349
DAX language, applying, 224
formatting, 158-162
limitations of, 225-226
See also OLAP

Data Connection Wizard

See also OLAP

Data areas, filling blank cells

Dashboards

Dashboards, 245

DAX language, applying, 224

DASH code, generating, 341

Dashboards

analyzing geographic data with, 261-273
building tours, 270-271
creating bubble/pie charts, 266
formatting column charts, 264
gooing data, 262-263

Data Models

applying, 345-351
benefits of, 224-225
code, generating, 349
DAX language, applying, 224
formatting, 158-162
limitations of, 225-226
See also OLAP

Data Connection Wizard

See also OLAP

Data areas, filling blank cells
multiple tables
    joining, 226-233
    merging, 223
navigating, 223-226
pivot tables, formatting, 232-233
relationships
    defining, 229-230
    managing, 162-163
tables
    adding, 163-165, 228, 346
deleting, 165
    formatting, 166
    unlimited rows, importing, 224
data over time, animating 3D Map, 269
data ranges, expanding, 361
data sets, 9
    exploding, 367-368
    selecting, 25
data sources
    analysis, 157
    blank cells, deleting, 22
calculated fields, adding to, 114
design, 22
    modifying, updating, 39-40
pivot tables, formatting, 168-174
data models
    connecting, 171
OLAP (online analytical processing)
    accessing functions, 211-213
    adding calculations, 213-222
    connecting, 204-206
    creating offline cubes, 209-211
    limitations of, 208-209
    navigating, 207-208
    overview of, 203-204
pivot tables, formatting, 169-171
    tabular layouts, 20
transactional, 203
Date Filters, applying, 103-104
dates
    grouping, 77-85
    selecting, 37
weeks, grouping, 81
DAX language
    applying, 224
calculated columns
    adding, 237
    applying calculations for, 239
calculated fields
    defining, 240-241
    filtering, 240
calculations, applying, 239-243
days
    filtering, 37
    grouping, 79
debugging, 292
default number formats, modifying, 312-313
default pivot tables, 46
    See also pivot tables
default sorting, overriding, 89
defer layout updates, 41-42, 297
deferring layout updates, 41-42
defining
    caches, 347
calculated fields (DAX), 240-241
custom lists, 94
pivot tables, 9
relationships
    in Data Models, 229-230
    Power Pivot add-in, 236
deleting
    blank cells, 22
calculations, 131
cells, preventing errors, 302
connections, 190
pivot tables, 146
subtotals, 64-67
tables, 165
descriptions of macros, 276
design
See also formatting
data sources, 22
workbooks as web pages, 193-196
Design tab, PivotTable Styles gallery, 60
dialog boxes
Advanced Editor, 182
Change PivotTable Data Source, 40
Create PivotChart, 139
Create PivotTable, 25, 159, 166, 228
Create Table, 163
Custom Lists, 93
Custom Name, 51
Excel Options, 78, 276
Existing Connections, 167
Field Settings, 84, 89
Format Cells, 49
Format Object, 281
Go To Special, 357
Grouping, 79-81
Import Data, 170, 206
Insert Calculated Field, 117, 120
Insert Calculated Item, 124
Insert Slicer, 34
Insert Timelines, 36, 143
Load To, 180
Macro, 286
Manage Relationships, 163
Modify PivotTable Quick Style, 62
More Sort Options, 91
Move Chart, 137
Move PivotTable, 43
New Calculated Measure, 216
New Calculated Member, 218
New Formatting Rule, 153
PivotTable Options, 209
Record Macro, 276
Report Connections, 35
Select Table, 170
Share, 196
Show Detail, 53
Show Report Filter Pages, 106
Solve Order, 132
Sort (Sector), 91
Value Field Settings, 48, 67, 233
Workbook Connections, 164
dimensions (OLAP), 207
Distinct Count command, 233
distributions, frequency, 82
docking fields, 87
documents
formulas, 133
themes, modifying, 62-63
dragging fields, 30
See also moving
drill-down, adding to charts, 251-252
driving multiple pivot tables, slicers,
110-112
drop-down lists, Areas section, 88-89
editing
calculations, 131
VBA code, 282
Visual Basic Editor, 291
elements
Power View, starting, 252
resizing, 251
tables, starting, 249
toggling, 56-60
eliminating blank cells, 311-312
empty cells, filling, 356-358
enabling
  macros, saving workbooks, 290
  Power Pivot add-in, 234
  VBA (Visual Basic for Applications), 289-290
End key, 294
End With statements, 295
entering
  formulas, 115
  GetPivotData, preventing, 379
Entire Field (+) button, 138
equal sign (=), 292
errors, preventing, 302
ETL processes, 174
Excel Help, 292
Excel Options dialog box, 78, 276
Excel Pro Plus (Power Pivot add-in), 225, 234-238
executing
  calculations, 113
  See also calculations
  OLAP what-if-analysis, 220-222
executive overviews, formatting, 329-332
Existing Connections dialog box, 167
Expand Entire Field (+) button, 138
expanding
  data ranges, 361
  ranges, 37
exploding workbooks to pivot tables, 372-373
expressions, MDX (multidimensional expressions), 214
external data sources, formatting, 157, 168-174
  See also data sources
Field Settings dialog box, 84, 89
fields
  See also columns; rows
  adding, 251, 298-299
  buttons, pivot charts, 138-139
  calculated. See calculated fields
categorizing, 245
filtering, 96-104
filters areas, adding, 104
formatting, 22
formulas, converting to, 213
lists
  applying, 83-89
  docking/undocking, 87
  moving, 87
models, adding to pivot tables, 348
modifying, viewing, 73
moving, 29
multiple, troubleshooting, 319-321
naming, 51, 121
numeric, grouping, 82
pivot charts, moving, 139-141
PivotTable Fields list
  searching, 26
  viewing, 208
rank number, adding, 359-360
Region, adding, 27
reports, adding to, 26-28
restrictions, applying, 368-371
rows
  filling empty cells left by, 356-358
  suppressing subtotals, 313-314
  subtotals, adding, 67, 80
values, modifying calculations, 67-75
files
formatting, 14
importing, 197
linking, 236
naming, 211
filling
blank cells
Data areas, 301
Row areas, 302
empty cells, 356-358
ranges, 23
filtering, 77, 95
AutoFilter, 363
calculated fields (DAX), 240
charts
applying tile boxes (Power View), 255
Power View, 252
check boxes, 96-97
columns, 96-104
conceptual filters, 339-340
Date Filters, 103-104
fields
applying lists, 83-89
converting to formulas, 213
items
in grand totals, 225
selecting, 105
labels, 98-99
multiple items, 105
pivot tables, 338-339
recordsets, 332-334
reports
applying, 105-107
formatting, 31
rows, 96-104
search boxes, 97-98
search filters, applying, 342-343
slicers, 37, 107-109
applying, 34
configuring, 343-345
timelines, applying, 107-110
Top 10 filter, applying, 101-102
Values columns, 99-101
filters areas, 12, 14, 27
applying, 104-112
fields, adding, 104
Filters pane, navigating Power View, 254-255
fonts, 62
See also themes
Format Cells dialog box, 49
Format Object dialog box, 281
formatting
3D Map charts, 266
calculated fields, 116-123
calculated items, 124-127
calculations
measures, 214-217
members, 217-219
columns, 246
charts, 264
Power Query, 185
dashboards, 196
Data Models, 158-162
fields, 22
files, 14
formulas, 115
frequency distributions, 82, 366-367
interfaces with form controls, 278-280
numbers, 48-49, 312-313, 364-365
pivot charts, 136-139
applying conditional, 149-151
as images, 146
customizing conditional, 152-156
limitations, 141
reports, 142-144
pivot tables, 14-15, 117
creating, 24-31
Data Model, 232-233
GetPivotData, 381-391
Power Pivot add-in, 237
preparing data for reporting, 19-24
SQL Servers, 171-174
summaries, 355-356
VBA (Visual Basic for Applications), 296-301
with external data sources, 168-174
Power View, 247-255
reports
filters, 31
models, 334-338
Power BI Desktop, 199-200
regions, 334-338
viewing by categories, 307-319
shell reports, 385-387
slicers
Power View, 253
timelines, 36-38
subtotals, 315
tables
Data Model, 166
Power Query, 186-188
relationships, 346-347
views, 9
web pages, sharing pivot tables, 193-196
forms
Compact, 52-53, 86
controls
formatting interfaces with, 278-280
inserting scrollbars, 281
formulas, 11
calculated fields, creating with, 115
Convert to Formulas option, 212
documenting, 133
entering, 115
GetPivotData, preventing, 379
troubleshooting, 377
frames, resizing elements, 251
frequency distributions, 82, 366-367
From Web command, 177
functions, 11
applying, 64
BLANK, 239
CHOOSE. See SWITCH function
cubes, navigating, 212-213
GETPIVOTDATA, 225
INDEX, 285
Index, 74
OLAP (online analytical processing),
accessing, 211-213
Sum, 321-322
SUMIFS, 239
SWITCH, 240
TEXT, 239
VLOOKUP, 239
worksheets, applying, 129

generating code
Data Models, 349
pivot tables, 300
reports, 319
summaries, 305
geocoding data, 262-263
GetPivotData, 375-376
  avoiding, 376-380
  closing, 379-380
  pivot tables, formatting, 381-391
  preventing, 379
GETPIVOTDATA function, 225
Go To Special dialog box, 357
grand totals
  items, filtering, 225
  subtotals, suppressing, 64-67
  viewing, 58
gridlines, restoring, 47
grouping, 77
  automatic, undoing, 78
  calculating, 325-327
  dates, 77-85
    selecting, 78
    weeks, 81
  Layout, 52
  months, 80
  numeric fields, 82
  repeating, avoiding, 21
  text, 82-85
  years, 80
Grouping dialog box, 79-81

H
hard data, formatting, 355-356
  See also summaries
hard values, modifying, 145
heat maps, 3D Map, 266
help (Excel Help), 292
hierarchies (OLAP), 207
hours, grouping, 79
How Many Customers to Show slicer, 194

I
images
  pivot charts, formatting as, 146
  Power View, populating with, 258
Import Data dialog box, 170, 206
importing
  data to Power BI, 197-198
  text (Power Pivot add-in), 235-236
  unlimited rows with Data Models, 224
INDEX function, 285
Index function, applying, 74
Insert Calculated Field dialog box, 117, 120
Insert Calculated Item dialog box, 124
Insert Slicer dialog box, 34
Insert Timelines dialog box, 36, 143
inserting
  calculated fields, 116
  cells, preventing errors, 302
  scrollbars, 281
  slicers, 33
    timeline slicers, 36, 143
intelligence, time, 242-243
IntelliSense, 298
interactive reports, pivot charts, 142-144
interfaces, formatting, 278-280
internal Data Models, 158-167
items
  calculated, applying, 324-325
  calculations, 124
    See also calculated items
  copying, 105-107
  grand totals, filtering, 225
  percentages, tracking, 73
  selecting, filtering, 105
sorting in unique orders, 355
specifying sorting, 91

**J**

joining multiple tables with Data Models, 226-233

**K**

keys
   End, 294
   primary, 162

**L**

Label Filters option, 98-99
labels
   filtering, 98-99
   points (3D Map), 266
   repeating, 53
languages
   DAX, 224
   *See also* DAX language
   VBA. *See* VBA (Visual Basic for Applications)
layers, adding, 28
Layout group, 52
layouts
   *See also* formatting
   classic, starting, 30
   Compact, applying, 52-53
   Outline, applying, 54-55
   pivot tables, 299-301
   report, modifying, 52-60
   reports, 27-28
   Tabular, 20, 55
   troubleshooting, 33
   updating
deferring, 41-42
levels (OLAP), 207
limitations
   of Data Model, 225-226
   of internal Data Models, 167
   of OLAP (online analytical processing), 208-209
   of VLOOKUP, 230
   pivot charts, formatting, 141
   pivot tables, 15, 301-307
lines
   % (percent), comparing with, 71
trends, 141
linking
   files (Power Pivot add-in), 236
   Web workbooks, 196
List Formulas command, 133
lists
   drop-down, applying, 88-89
   fields
      applying, 83-89
      docking/undocking, 87
      moving, 87
   PivotTable Fields
      searching, 26
      viewing, 208
   pivot tables
      sorting, customizing, 93-94
Load button, 176
Load To dialog box, 180
locations
   pivot charts, moving, 137
   reports, 25
   **M**

Macro dialog box, 286
macros, 275
   applying, 275-276
   assigning, 279
customizing, 280-288
enabling, saving workbooks, 290
forms, creating interfaces with controls, 278-280
naming, 276
pivot charts, synchronizing, 283-287
recorders, 292
recording, 276-278
scrollbars, inserting, 281
security, 277-278
shortcuts, 276
storing, 276
VBA. See VBA (Visual Basic for Applications)
maintenance, calculations, 131-133
Manage Relationships dialog box, 163
management
  caches, sharing, 40-41
calculations, 131-133
OLAP (online analytical processing), 220
  Power Query, 183-185
  query steps, 182
  relationships, 162-163
manual sequences, sorting, 92-93
ManualUpdate property, 297
Map, 257
maps. See 3D Map
MDX (multidimensional expressions), 214
MDX Calculated Measure command, 215
MDX Calculated Member command, 218
measures
  calculations, formatting, 214-217
  OLAP (online analytical processing), 208
members
  calculations, formatting, 217-219
  OLAP (online analytical processing), 207
memory, 14
merging multiple tables with Data Models, 223
methods
  AddFields, 298
  CreatePivotTable, 297
Microsoft Access, formatting, 169-171
minutes, grouping, 79
models
  Data Models. See Data Models fields, adding to pivot tables, 348
  internal Data Model, 158-167
  reports, formatting, 334-338
modes, Compatibility, 16
Modify PivotTable Quick Style dialog box, 62
modifying
  calculations (Power View), 259
  data sources, updating, 39-40
default number formats, 312-313
document themes, 62-63
fields
  naming, 51
  viewing, 73
  macros, 280-288
pivot tables
  customizing, 46-51
  hard values 145
  modifying pivot charts, 139
  relationships, 162
  report layouts, 52-60
styles, 62-63
summary calculations, 63-64
months
  filtering, 37
  grouping, 79, 80
More Sort Options dialog box, 91
Move Chart dialog box, 137
Move PivotTable dialog box, 43
moving
  columns, 92
  fields, 29
  lists, 87
  pivot charts, 139-141
  pivot tables, 43
multidimensional expressions. See MDX
multiple fields, troubleshooting, 319-321
multiple items, filtering, 105
multiple pivot tables, driving slicers, 110-112
multiple ranges, 157
  See also data sources
multiple row fields, suppressing subtotals, 313-314
multiple subtotals, adding fields, 67
multiple tables (Data Model)
  joining, 226-233
  merging, 223

N

Name property, 322
named ranges, applying, 129
named sets, 225
naming
  calculated fields, 118
  calculated items, 125
  cubes, 211
  fields, 51, 121
  macros, 276
  pivot tables, 36
navigating
  3D Map, 264-265
  cubes, functions, 212-213
  Data Model, 223-226
  End keys, 294
  Filters pane (Power View), 254-255
  OLAP (online analytical processing), 207-208
  pivot tables, 12-14
  Recommended Pivot Table feature, 31-33
  tools, new features, 41-43
Navigator pane, 176
New Calculated Measure dialog box, 216
New Calculated Member dialog box, 218
new features, 2
  tools, 41-43
New Formatting Rule dialog box, 153
numbers
  default, modifying, 312-313
  formatting, 48-49, 364-365
numeric fields
  grouping, 82
  Values area, adding to, 348-349

O

object-oriented code, 292-293
objects
  PivotLayout, 136
  variables, applying, 294-295
Off for Rows and Columns setting, 59
offline cubes, creating, 209-211
OLAP (online analytical processing)
  calculations
    adding, 213-222
    managing, 220
  connecting, 204-206
  functions, accessing, 211-213
  limitations of, 208-209
  navigating, 207-208
offline cubes, creating, 209-211
overview of, 203-204
what-if-analysis, executing, 220-222
One Click, 42
OneDrive
files, importing from, 198
saving to, 195
online analytical processing. See OLAP
operator precedence, 128
optimizing
3D Map, 267-269
pivot tables, 11, 329-345
options
Add This Data to the Data Model, 25
Analysis Services, 204
Convert, 16
Convert to Formulas, 212
Count Distinct, 224
Defer Layout Update, 41-42
Index, 74
Label Filters, 98-99
macros, 280-288, 290
Quick Analysis, 32
Repeat All Item Labels, 53, 357
Summarize Values By command, 64
Value Field Settings dialog box, 67
order
solve, modifying calculated items, 132
sort
controlling, 312
formatting, 90
See also sorting
Outline layout, 54-55, 299
overriding
Count calculations, 64
default sorting, 89
overwriting caches, 39

P

page breaks, adding subtotals, 315
Page Layout tab, 62
pages, adding sectors, 107
parent items, tracking percentages, 73
paths, adding, 246
percentages
totals, viewing, 70
tracking, 73
percentages, calculating parent items, 73
pictures. See images
pie charts, creating, 266
pivot charts
alternatives to, 145-148
conditional formatting
applying, 149-151
customizing, 152-156
fields
applying buttons, 138-139
moving, 139-141
formatting, 136-139
images, formatting as, 146
interactive reports, 142-144
limitations of formatting, 141
locations, moving, 137
overview of, 135-136
rules, 139-144
source data, applying cells as, 147-148
synchronizing, 283-287
types of, selecting, 136
viewing, 137
Pivot Power Premium add-in, 47
pivot tables
advantages of, 11
analysis, 157
applying, 10-12
pivot tables

AutoFilter, 363
automating, refreshing, 353
backward compatibility, 15-17
caches, defining, 347
code, generating, 300
comparing, 361
creating, 24-31
customizing, 45
  adding/removing subtotals, 64-67
  applying functions, 64
Compact layout, 52-53
configuring calculations, 67-75
formatting numbers, 48-49
modifying, 46-51
naming fields, 51
Outline layout, 54-55
replacing blanks with zeros, 49-50
report layouts, 52-60
restoring gridlines, 47
styles, 60-63
summary calculations, 63-64
Tabular layout, 55
toggling elements, 56-60
Data Models, formatting, 232-233
defining, 9
deleting, 146
external data sources, formatting, 168-174
filtering, 338-339
formatting, 14-15, 117
frequency distributions, formatting, 366-367
GetPivotData, formatting, 381-391
hard values, modifying, 145
layouts, 299-301
limitations, 15, 301-307
model fields, adding to, 348
moving, 43
naming, 36
numbers, formatting, 364-365
optimizing, 329-345
overview of, 12-14
Power Pivot add-in
  comparing, 238-239
  formatting, 237
preparing data for reporting, 19-24
rank number fields, adding, 359-360
rearranging, 29
refreshing, 276
reports, sizing, 360
restrictions, 368-371
sharing, 193
  formatting web pages, 193-196
  linking Web workbooks, 196
  with Power BI Desktop, 196-202
simultaneously, refreshing, 354
slicers, configuring, 343-345
SQL Servers, formatting, 171-174
summaries, formatting, 343-345
tabs, exploding data sets to, 367-368
values, converting to, 55-57, 304-305
VBA (Visual Basic for Applications)
calculating, 319-329
formatting, 296-301
workbooks
  copying, 314-315
  exploding to, 372-373
PivotLayout objects, 136
PivotTable Fields list
  searching, 26
  viewing, 208
PivotTable Options dialog box, 209
PivotTable Styles gallery, 60
points, labeling (3D Maps), 266
populating
Power View images, 258
shell reports, 387-390

**Position property, 298**

**Power BI Desktop**
- pivot tables, sharing, 196-202
- reports, formatting, 199-200

**Power Pivot add-in, 225**
- applying, 234-238
- enabling, 234
- files, linking, 236
- pivot tables
  - comparing, 238-239
  - formatting, 237
- relationships, defining, 236
text, importing, 235-236

**Power Query**
- applying, 174-192
- columns, formatting, 185
- connecting, 188-192
- managing, 183-185
- overview of, 175-180
- refreshing, 183
- steps, 181-182
tables, formatting, 186-188

**Power View, 245**
calculations, modifying, 259
charts
  - adding drill-down to, 251-252
  - copying, 256
  - filtering, 252
elements, starting, 252
Filters pane, navigating, 254-255
formatting, 247-255
images, populating with, 258
overview of, 261
preparing data, 245-247
scatter charts, animating, 259-260
slicers, creating, 253
sorting, 249
tables, converting to charts, 250-251
tile boxes, filtering charts, 255

**precalculations, 114**
- See also calculations

**precedence, operators, 128**

**preparing data for reporting, 19-24**

**preventing**
- errors, 302
  - GetPivotData, 379

**primary keys, 162**

**processes, ETL, 174**

**productivity, 11**

**Project Explorer, 291**

**properties**
- Caption, 322
- ManualUpdate, 297
- Name, 322
- Position, 298
- ShowDetail, 332-334

**Properties window, 291**

**Q**

**Q&A, querying with, 200**

**quarters**
- filtering, 37
- grouping, 79

**queries**
- See also Power Query
  - Access (Microsoft), 169
  - Power Query, applying, 174-192
  - starting, 175
  - steps, managing, 182
  - with Q&A, 200

**Query Editor, 177, 182**
- Preview pane, 187
Query Settings command, 181
Quick Analysis option, 32

ranges
converting, 163
data, sizing, 293-294
expanding, 37, 361
multiple, 157
named, applying, 129
selecting, 23
updating, 40

rank
number fields, adding, 359-360
viewing, 71

rearranging. See moving
Recommended Pivot Table, navigating, 31-33

Record Macro dialog box, 276
recorders, macros, 292
recording macros, 276-278
records, counting, 322
recordsets, filtering, 332-334
references
cells, applying, 129
totals, 129

refreshing
caches, 15
pivot tables, 276
automatically, 353
simultaneously, 354
Power Query, 183
Region field, adding, 27
region maps (3D Maps), 266
regions, formatting reports, 334-338

relationships
Data Models
defining, 229-230
managing, 162-163
Power Pivot add-in, defining, 236
tables, formatting, 346-347

relocating. See moving
Repeat All Item Labels option, 53, 357
repeating groups, avoiding, 21
replacing blanks with zeros, 49-50
replicating. See copying
Report Connections dialog box, 35
reports
code, generating, 319
executive overviews, formatting, 329-332
fields, adding to, 26-28
filtering, copying, 105-107
formatting
filters, 31
models, 334-338
pivot charts, 142-144
Power BI Desktop, 199-200
regions, 334-338
viewing by categories, 307-319
layouts, 27-28, 52-60
locations, 25
macros, 275

See also macros
applying, 275-276
creating interfaces with form controls, 278-280
customizing, 280-288
inserting scrollbars, 281
recording, 276-278
synchronizing pivot charts, 283-287
preparing data for, 19-24
shell. See shell reports
sizing, 360
Top 10 filter, applying, 101
resizing elements, 251
restoring gridlines, 47
restrictions, applying, 368-371
Row areas, 12-13, 27, 302
rows
  Blank Rows setting, 57
data sources, expanding, 39
fields
  filling empty cells left by, 356-358
  suppressing subtotals, 313-314
filtering, 96-104
grand totals, viewing, 58
Off for Rows and Columns setting, 59
rules
  calculated fields, 129
calculated items, 131
calculations, 127-131
New Formatting Rule dialog box, 153
pivot charts, 136
ranges, 23
separators, adding thousands, 48-49
sequences (manual), applying to sorting, 92-93
services, Analysis Services option, 204
sets, named, 225
shaping (data), 10
  See also formatting
Share dialog box, 196
Share with People command, 196
sharing
  caches, 40-41
dashboards, 202
pivot tables, 193
  formatting web pages, 193-196
  linking Web workbooks, 196
  with Power BI Desktop, 196-202
videos (3D Map), 271
shell reports
  building, 385-387
  populating, 387-390
  updating, 390-391
shortcuts
  macros, 276
  pivot charts, starting, 25
  Recommended Pivot Table feature, 31-33
shortening VBA code, 295
Show Detail dialog box, 53
Show Report Filter Pages dialog box, 106
Show Values As tab, 67-69, 327-329
ShowDetail property, 332-334
sizing
data ranges, 293-294
reports, 360
slicers
applying, 33-38, 107-109
configuring, 343-345
connecting, 35
How Many Customers to Show, 194
inserting, 33
multiple pivot tables, driving, 110-112
Power View, creating, 253
timelines
creating, 36-38
inserting, 143
Solve Order dialog box, 132
solve order, modifying calculated items, 132
Sort (Sector) dialog box, 91
sorting, 77, 89-94
AutoSort, applying, 312
customers, 89-92
fields, applying lists, 83-89
items
in unique orders, 355
specifying, 91
lists, customizing, 93-94
manual sequences, applying, 92-93
Power View, 249
sectors, 91
source data, applying cells as pivot charts, 147-148
spans, filtering, 101
specifying items, sorting, 91
SQL Servers, formatting, 171-174
starting
classic layouts, 30
elements (Power View), 252
pivot tables, 24
queries, 175
Recommended Pivot Tables, 31
tables, elements, 249
statements, End With, 295
steps (Power Query), 181-182
stock charts, 141
storing
macros, 276
section headings, avoiding, 20
styles
customizing, 46, 60-63
gridlines, restoring, 47
layouts, 52
See also layouts
modifying, 62-63
PivotTable Styles gallery, 60
subtotals, 299
adding, 64-67, 80, 315
deleting, 64-67
formatting, 315
suppressing, 313-314
Sum function, 321-322
SUMIFS function, 239
summaries, 309-311
calculated fields, 120-123
calculations, modifying, 63-64
code, generating, 305
pivot tables, formatting, 355-356
Summarize Values By command, 64
summing totals, 298
suppressing subtotals, 64-67, 313-314
SWITCH function, 240
synchronizing pivot charts, 283-287
tables
See also pivot tables
comparing, 361
Data Model
adding, 163-165, 228, 346
deleting, 165
formatting, 166
elements, starting, 249
joining, 226-233
pivot. See pivot tables
Power Query, formatting, 186-188
Power View, converting to charts, 250-251
relationships, formatting, 346-347
Transactions, 158
tabs
data sets, exploding, 367-368
pivot tables, exploding data sets to, 367-368
Tabular layout, 20, 299, 309
text
grouping, 82-85
Power Pivot add-in, importing, 235-236
TEXT function, 239
themes, modifying, 62-63
thousands separators, adding, 48-49
tile boxes (Power View), 255
time
data over, animating 3D Map, 269
filtering, 37
grouping, 79
intelligence, applying, 242-243
scatter charts, animating, 259-260
timelines
applying, 107-110
slicers
creating, 36-38
inserting, 143
titles, charts, 141
toggling elements, 56-60
tools
new features, 41-43
pivot tables. See pivot tables
Power BI Desktop, 196-202
VBA (Visual Basic for Applications), 291-292
Top 10 filter, applying, 101-102
totals, 65-67
See also grand totals; subtotals
controlling, 302-304
percentages, viewing, 70
references, 129
running, tracking, 72
summing, 298
tours, building 3D Maps, 270-271
tracking
Index function, 74
percentages, 73
running totals, 72
transactional databases, 203
Transactions table, 158
trend lines, 141
troubleshooting
caches, overwriting, 39
calculations, 131-133
counting, 63-64
Excel Help, 292
formulas, 377
GetPivotData, avoiding, 376-380
layouts, 33
multiple fields, 319-321
Trust Center, enabling VBA, 289-290
turning off GetPivotData, 379-380
types
  of filters, 339-340
  of pivot charts, selecting, 136

U
undocking fields, 87
undoing automatic grouping, 78
unique orders, sorting items in, 355
unlimited rows, importing Data Models, 224

updating
  data sources, modifying, 39-40
  layouts, deferring, 41-42
  ranges, 40
  shell reports, 390-391

V
Value Field Settings dialog box, 48, 67, 233
values
  fields, modifying calculations, 67-75
  pivot tables, converting to, 55-57, 304-305
  slicers, selecting, 34
Values areas, 12-13, 27
  blanks, replacing with zeros, 49-50
  fields, naming, 51
  numeric fields, adding to, 348-349
Values columns, filtering, 99-101
variables, applying objects, 294-295
VBA (Visual Basic for Applications), 289
  AutoShow, applying, 329-332
  code
    applying object variables, 294-295
    editing, 282
    shortening, 295
    sizing data ranges, 293-294
  conceptual filters, applying, 339-340
  Data Models, applying, 345-351
  enabling, 289-290
  macro recorders, 292
  object-oriented code, 292-293
  pivot tables
    calculating, 319-329
    filtering, 338-339
    formatting, 296-301
    limitations, 301-307
  region reports, formatting, 334-338
  reports, creating, 307-319
  search filters, applying, 342-343
  ShowDetail property, 332-334
  slicers, configuring, 343-345
  tools, 291-292
  versions, 295-296
  Visual Basic Editor, 291
  workbooks, saving to enable macros, 290
versions
  checking, 16
  VBA (Visual Basic for Applications), 295-296
videos, sharing, 271
viewing
  categories, 307-319
  fields, modifying, 73
  grand totals, 58
  percentages of totals, 70
  pivot charts, 137
  PivotTable Fields list, 208
  rank, 71
  running totals, 72
views, formatting, 9
Visual Basic Editor, 283, 291
Visual Basic for Applications. See VBA
VLOOKUP
functions, 239
limitations of, 230
tables, merging without, 223

W
web pages, sharing pivot tables, 193-196
weeks, grouping dates, 81
what-if-analysis, executing OLAP, 220-222
windows
  Code, 291
  Power View, 248
    See also Power View
  Properties, 291
Windows Authentication, 172
wizards
  Create Cube File, 210
  Data Connection Wizard, 172, 204
Workbook Connections dialog box, 164
Workbook Queries pane, 183
workbooks
  macros, assigning, 279
  pivot tables
    copying, 314-315
    exploding to, 372-373
  saving, enabling macros, 290
  web pages, designing as, 193-196
  Web, linking, 196
worksheets
  backward compatibility, 15-17
  Data Models, formatting, 158-162
  functions, applying, 129
writing VBA code
  applying object variables, 294-295
  shortening, 295
  sizing data ranges, 293-294

X
x-axis, 140
XY (scatter) charts, 141

Y
y-axis, 140
years
  filtering, 37
  grouping, 79, 80

Z
zeros, replacing blanks, 49-50